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1. Titulo

“Ocupacion del suelo del area urbana de la parroquia Vilcabamba, canton y

provincia de Loja con fines de Gestion y Ordenamiento Territorial”



2. Resumen

El trabajo de investigacion titulado "Ocupacion del suelo del area urbana de la
parroquia Vilcabamba, cantdon y provincia de Loja con fines de Gestién vy
Ordenamiento Territorial" representa un esfuerzo significativo para comprender y
analizar la realidad del territorio en cuestion. El enfoque cualitativo y cuantitativo
adoptado proporciona una vision integral de la ocupacion del suelo en la cabecera
parroquial, permitiendo asi la obtencion de informacion detallada y actualizada

necesaria para la toma de decisiones futuras.

La utilizacion del software ArcGIS 10.3 para el procesamiento de informacion
muestra mayor precision y eficiencia en la recopilacion y analisis de datos. La
actualizacion del diagnéstico a través del trabajo de campo, que incluyo la recoleccion
de datos mediante fichas y registros fotograficos, indica la comprension directa con la
realidad del area de estudio. La inclusion de variables como litologia, topografia,
pendiente, redes de infraestructura, equipamientos y uso actual del suelo en el anélisis
proporciona una vision completa de la situacion territorial. Este enfoque integral es
esencial para comprender la complejidad de diversos factores que afectan la
ocupaciéon del suelo en la parroquia. El trabajo en campo se destaca como un
componente necesario para el levantamiento de informacion, ya que permite una
apreciacion directa de la realidad del territorio. La subclasificacion de areas en suelo
urbano consolidado, suelo urbano no consolidado y suelo urbano de proteccion
demuestra una comprension detallada de la diversidad del territorio y sus
caracteristicas especificas, proporcionando una visibn mas completa de la dinamica
urbana. El mapa final de ocupacion del suelo, que destaca las categorias de
"desarrollo" y "formacién”, indica que la parroquia esta experimentando un periodo de
crecimiento y progreso en diversos aspectos. Este resultado es crucial para la toma
de decisiones informada, ya que sefala la necesidad de politicas y estrategias para
una mejor gestion del territorio. En resumen, el presente trabajo de investigacion
representa un valioso aporte al conocimiento del area urbana de la parroquia
Vilcabamba, brindando informacion esencial para la toma de decisiones y el disefio
de politicas de gestion y ordenamiento territorial que contribuyan al desarrollo
sostenible de la region.

Palabras clave: litologia, pendientes, suelo urbano consolidado, suelo urbano de

proteccion, ocupacion del suelo.



Abstract

The research work entitled "Land occupation of the urban area of the Vilcabamba
parish, canton and province of Loja for the purposes of Territorial Management and
Planning" represents a significant effort to understand and analyze the reality of the
territory in question. The qualitative and quantitative approach adopted provides a
comprehensive view of land occupation in the parish seat, thus allowing the obtaining

of detailed and updated information necessary for future decision-making.

The use of ArcGIS 10.3 software for information processing shows greater precision
and efficiency in data collection and analysis. The updating of the diagnosis through
field work, which included the collection of data through cards and photographic
records, indicates direct understanding with the reality of the study area. The inclusion
of variables such as lithology, topography, slope, infrastructure networks, equipment
and current land use in the analysis provides a complete vision of the territorial
situation. This comprehensive approach is essential to understand the complexity of
various factors that affect land occupation in the parish. Field work stands out as a
necessary component for collecting information, since it allows a direct appreciation of
the reality of the territory. The subclassification of areas into consolidated urban land,
unconsolidated urban land and protective urban land demonstrates a detailed
understanding of the diversity of the territory and its specific characteristics, providing
a more complete view of urban dynamics. The final land occupation map, which
highlights the categories of "development" and "formation”, indicates that the parish is
experiencing a period of growth and progress in various aspects. This result is crucial
for informed decision-making, since it indicates the need for policies and strategies for
better management of the territory. In summary, this research work represents a
valuable contribution to the knowledge of the urban area of the Vilcabamba parish,
providing essential information for decision-making and the design of management and

territorial planning policies that contribute to the sustainable development of the region.

Keywords: lithology, slopes, consolidated urban land, urban protection land, land

occupation.



3. Introduccién

El estudio de la ocupacion del suelo es fundamental para entender el crecimiento
urbano, la sostenibilidad ambiental, la gestion de recursos y la planificacion a largo
plazo. En muchos casos, se realizan investigaciones y andlisis para evaluar la
eficiencia en el uso del suelo, identificar areas de riesgo, planificar el desarrollo urbano

sostenible y tomar decisiones informadas sobre politicas de ordenamiento territorial.

La parroquia de Vilcabamba cuenta con una poblacion segun el INEC de 4.778
habitantes en el afio 2010, la cual es la principal afectada y responsable del uso y
ocupaciéon inadecuado del suelo, esto acarrea problemas tales como, expansion
acelerada del limite urbano, perdidas de zonas protegidas, deforestacion,
contaminacion de redes hidricas, uso ineficiente de espacios publicos, insuficiente

infraestructura de uso comunitario, déficit de cobertura de servicios basicos.

Considerando los antecedentes el presente proyecto pretende obtener informacion
actualizada acerca del uso y ocupacién del suelo de la parroquia Vilcabamba, la cual
servirh como insumo principal para toma de decisiones y servira para la ejecucion
estratégica de proyectos y viabilizar los planeamientos definidos en el Plan de
Ordenamiento Territorial para un 6ptimo desarrollo de la parroquia y por ende del

canton.
Para el desarrollo de esta investigacion se plantea los siguientes objetivos:

e General
o Obtener la ocupacién del suelo del area urbana de la parroquia
Vilcabamba
e Especificos
o Actualizar el diagnostico urbano de la cabecera parroquial de Vilcabamba
o Catalogar la clasificacion y subclasificacion del uso de suelo de acuerdo
ala LOOTUGS.

o Elaborar el mapa de ocupacion del suelo del area de estudio.



4. Marco Teorico

4.1 Planes de Uso y Gestion del Suelo (PUGS)

Segun el MIDUVI (2018) el PUGS es el instrumento con el que el Estado, a través
de los Gobiernos Autonomos Descentralizados Municipales, puede asegurar el
cumplimiento de los articulos 31 y 321 de la Constitucion; es decir, esto se logra
mediante el establecimiento de normas urbanisticas que definan de forma clara y
precisa, los derechos y obligaciones que tienen los propietarios sobre sus terrenos o

construcciones.

El Plan de Uso y Gestién del Suelo (PUGS), como componente integral y
fundamental del Plan de Desarrollo y Ordenamiento Territorial, permite a los
Gobiernos Auténomos Descentralizados Municipales generar una serie de acciones
encaminadas a la ocupacion racionalizada, la preservacion y recuperacion del suelo
urbano y de expansién urbana, como base para el mejoramiento de la calidad de vida

de la poblacion.

4.2 Objetivo de los PUGS
De acuerdo al MIDUVI (2018) el Plan de Uso y Gestion del Suelo establece e
instrumentaliza las politicas y actuaciones, a través de las cuales se tiene por objeto:

+ Establecer mecanismos eficaces que permitan viabilizar los planteamientos
definidos en el Plan de Desarrollo y Ordenamiento Territorial del canton.

+ Establecer mecanismos y normativas adecuadas, enmarcados en la ley, para
gue el ordenamiento territorial sea funcional al desarrollo de las areas urbanas
y rurales del cantén.

« Establecer instrumentos y alternativas en materia de gestion del suelo que
hagan factible la ejecucion de estrategias planteadas en el ordenamiento
urbanistico y la distribucion equitativa de cargas y beneficios entre la

administracion municipal y los particulares (MIDUVI, 2018)

4.3 Componentes del PUGS
El Plan de Uso y Gestidbn de Suelo tiene dos componentes: estructurante y

urbanistico.



4.3.1 Componente Estructurante

Segun la LOOTUGS (2016), el componente estructurante estara constituido por los
contenidos de largo plazo que respondan a los objetivos de desarrollo y al modelo
territorial deseado segun lo establecido en el plan de desarrollo y ordenamiento
territorial municipal o metropolitano, y las disposiciones correspondientes a otras
escalas del ordenamiento territorial, asegurando la mejor utilizacion de las
potencialidades del territorio en funcion de un desarrollo armoénico, sustentable y
sostenible, a partir de la determinacion de la estructura urbano-rural y de la

clasificacion del suelo.

4.3.2 Componente Urbanistico

De acuerdo a la LOOTUGS (2016), el Componente Urbanistico del PUGS
determina el uso, la edificabilidad y el aprovechamiento del suelo de acuerdo con su
clasificacion y sub-clasificacion urbana y rural, asi como los instrumentos de gestion

a ser empleados segun los requerimientos especificos.

4.4 Suelo

La LOOTUGS (2016) menciona que “el suelo es el soporte fisico de las actividades
que la poblacion lleva a cabo en busqueda de su desarrollo integral sostenible y en el
gue se materializan las decisiones y estrategias territoriales, de acuerdo con las

dimensiones social, econdmica, cultural y ambiental”

4.4.1 Suelo Urbano

De acuerdo a la LOOTUGS (2016), el suelo urbano es el ocupado por
asentamientos humanos concentrados que estan dotados total o parcialmente de
infraestructura basica y servicios publicos, y que constituye un sistema continuo e
interrelacionado de espacios publicos y privados. Estos asentamientos humanos

pueden ser de diferentes escalas e incluyen nucleos urbanos en suelo rural.
Para el suelo urbano se establece la siguiente subclasificacion:

a) Suelo urbano consolidado. Se refiere al suelo urbano que cuenta con todos de
los servicios, equipamientos e infraestructuras necesarios, y que

principalmente se encuentra ocupado por edificaciones.



b) Suelo urbano no consolidado. Se lo define al suelo urbano que carece de la

totalidad de los servicios, infraestructuras y equipamientos necesarios, y que
demanda de un proceso para finalizar o mejorar su edificacion o urbanizacion.
Suelo urbano de proteccién. Se denomina suelo urbano a aquel que por sus
particulares caracteristicas biofisicas, culturales, sociales o paisajisticas, o por
la presencia de factores de riesgo para los asentamientos humanos, debe ser
protegido. Este suelo esta sujeto a restricciones segun la legislacion nacional y
local correspondiente. Para la declaratoria de suelo urbano de proteccion, los
planes de desarrollo y ordenamiento territorial municipales o metropolitanos
sera llevada a cabo con lo dispuesto en la legislacion nacional ambiental,

patrimonial y de riesgos.

4.4.2 Suelo Rural

De acuerdo a la LOOTUGS (2016), el suelo rural es el destinado principalmente a

actividades agro productivas, extractivas o forestales, o el que por sus especiales

caracteristicas biofisicas o geogréficas debe ser protegido o reservado para futuros

usos urbanos.

Para el suelo rural se establece la siguiente subclasificacion:

a)

b)

Suelo rural de produccién. Es el suelo rural destinado a actividades
agroproductivas, acuicolas, ganaderas, forestales y de aprovechamiento
turistico, respetuosas del ambiente. Consecuentemente, se encuentra
restringida la construccion y el fraccionamiento.

Suelo rural para aprovechamiento extractivo. Es el suelo rural destinado por la
autoridad competente, de conformidad con la legislacion vigente, para
actividades extractivas de recursos naturales no renovables, garantizando los
derechos de naturaleza.

Suelo rural de expansion urbana. Es el suelo rural que podra ser habilitado para
su uso urbano de conformidad con el plan de uso y gestion de suelo. El suelo
rural de expansion urbana sera siempre colindante con el suelo urbano del
cantdon o distrito metropolitano, a excepcion de los casos especiales que se
definan en la normativa secundaria. La determinacién del suelo rural de
expansion urbana se realizara en funcion de las previsiones de crecimiento

demografico, productivo y socioeconémico del cantdén o distrito metropolitano,



y se ajustara a la viabilidad de la dotacion de los sistemas publicos de soporte
definidos en el plan de uso y gestiéon de suelo, asi como a las politicas de
proteccion del suelo rural establecidas por la autoridad agraria o ambiental
nacional competente.

d) Suelo rural de proteccién. Es el suelo rural que debido a sus particulares
caracteristicas biofisicas, ambientales, paisajisticas o socioculturales, asi como
por la presencia de factores de riesgo, demanda medidas especificas de
proteccion. Este tipo de suelo no es apto para la realizacion de actividades de
ningun tipo, que alteren su condicion de proteccion, por lo que se establecen
restricciones tanto para la construccion como para el fraccionamiento. Para la
declaratoria de suelo rural de proteccién se observara la legislacion nacional

gue sea aplicable.

4.5 Uso del suelo
El uso es la destinacion asignada al suelo, conforme con su clasificacion y
subclasificacion, previstas en la Ley. Los usos seran determinados en los respectivos

planes de uso y gestion de suelo y en sus instrumentos complementarios.

4.5.1 Destino de los usos del suelo

Segun resolucion Nro. 005-CTUGS-2020 emitida por el Consejo Técnico de Uso y
Gestidon de Suelo en el articulo 33 se menciona que “...los usos del suelo podran tener
los siguientes destinos, cuya terminologia es de caracter obligatorio, mas la

subclasificacion dependera de la realidad de cada cantén.”

a) Uso Residencial: Se destina para vivienda permanente, en uso exclusivo o
combinado con otros usos de suelo compatibles, en edificaciones individuales
o colectivas del territorio. El suelo residencial puede dividirse de acuerdo a la
densidad establecida.
Residencial de baja densidad. - son zonas residenciales con presencia limitada
de actividades comerciales y equipamientos de nivel barrial. En esta categoria
pueden construirse edificaciones unifamiliares con pocos pisos de altura.
Residencial de mediana densidad. - son zonas residenciales que permiten
actividades econdémicas, comerciales y equipamientos para el barrio o un sector

de mayor area dentro de la ciudad.



b)

d)

Residencial de alta densidad. - son zonas residenciales con mayor ocupacion
(a nivel de edificabilidad) que permiten actividades comerciales, econémicas y
equipamientos que por su escala pueden servir a un sector grande de la ciudad.
Uso Mixto: Es el uso que se le da al suelo con mezcla de actividades
residenciales, comerciales, de oficina, industriales de bajo impacto, servicios y
equipamientos compatibles. Generalmente se ubica en las zonas de
centralidad de la ciudad o en los ejes de las vias principales

Uso Equipamiento: Es suelo destinado a actividades e instalaciones que
generen bienes y servicios sociales y publicos para satisfacer las necesidades
de la poblacion o garantizar su esparcimiento, independientemente de su
caracter publico o privado

Uso Industrial: Es el destinado a las areas de la ciudad en suelo rural o urbano,
con presencia de actividad industrial de variado impacto, que producen bienes
o productos materiales. De acuerdo con el impacto, el suelo industrial puede
ser:

Industrial de bajo impacto. - Corresponde a las industrias o talleres pequefios
gue no generan molestias ocasionadas por ruidos menores a 60dB, malos
olores, contaminaciéon, movimiento excesivo de personas o vehiculos, son
compatibles con usos residenciales y comerciales.

Industrial de mediano impacto. - Corresponde a industrias que producen ruido
desde los 60dB, vibracion y olores, condicionados o no compatibles con usos
de suelo residencial.

Industrial del alto impacto. - Corresponde a las industrias peligrosas por la
emision de combustidn, emisiones de procesos, emisiones de ruido, vibracién
o residuos solidos, su localizacion debe ser particularizada.

Industrial de Alto Riesgo. - Corresponde a las industrias en los que se
desarrollan actividades que implican impactos criticos al ambiente y alto riesgo
de incendio, explosion o emanaciéon de gases, por la naturaleza de los
productos y substancias utilizadas y por la cantidad almacenada de las mismas.
Uso comercial y de servicios: Es el suelo destinado a actividades de
intercambio de bienes y servicios en diferentes escalas y coberturas, en uso
exclusivo o combinados con otros usos de suelo en areas del territorio, predios

independientes y edificaciones



4.6 Edificabilidad

La LOOTUGS (2016), menciona que “la edificabilidad es la capacidad de desarrollo
edificable establecida por la entidad municipal o metropolitano del GAD”. La capacidad
de aprovechamiento constructivo atribuida se llevara a cabo a través de la asignacion
de:

+ La edificabilidad general maxima. Es la edificabilidad total asignada a un
poligono de intervencion territorial o a cualquier otro &mbito de planeamiento, y
se asignara en el plan de uso y gestion del suelo.

+ La edificabilidad especifica maxima. Es la edificabilidad asignada a un

determinado predio de forma detallada.

4.7 Edificabilidad basica

De acuerdo a la LOOTUGS (2016), la edificabilidad basica es la capacidad de
aprovechamiento constructivo atribuida al suelo por el Gobierno Auténomo
Descentralizado municipal o metropolitano que no requiere de una contraprestacion
por parte del propietario de dicho suelo. ElI Gobierno Autbnomo Descentralizado
municipal o metropolitano determinara la edificabilidad basica y podra otorgar de
manera onerosa el aprovechamiento superior al basico a excepcion de los casos

obligatorios que se definan en la Ley o normativa secundaria.

4.8 Ocupacion del Suelo

Segun la LOOTUGS (2016), la ocupacion del suelo es la distribucion del volumen
edificable en un terreno en consideracion de criterios como altura, dimensionamiento
y localizacion de volumenes, forma de edificacion, retiros y otras determinaciones de
tipo morfologicos. La ocupacién de suelo serd determinada por los Gobiernos
Autonomos Descentralizados municipales y metropolitanos mediante su normativa
urbanistica que comprendera al menos el lote minimo, los coeficientes de ocupacion,

aislamientos, volumetrias y alturas, conforme lo establecido en la Ley.

4.9 Coeficiente de Ocupacion

De acuerdo al MIDUVI (2018), es el porcentaje o area determinada de un predio
gue podra ser desarrollada con edificacion tanto en la planta baja como en la altura
asignada por el plan de uso y gestion de suelo. El coeficiente de ocupacion en planta

tiene estrecha relacion con la forma de edificacion dispuesta para una parcela.
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Figura 1.

Coeficiente de ocupacién en PB y Total

D AREA DEL TERRENO D AREA DEL TERRENO

AREA DE TERRENO CONSTRUIBLE AREA DE TERRENO CONSTRUIBLE
r—a r—a
|_ | cosps | | COSTOTAL

Nota: Fuente: (MIDUVI, 2018)

4.10 Sistema de Informacion Geogréfico

Los autores Star y Estes (1990) indican que el SIG “es un sistema disefiado para
manipular datos que estan referenciados mediante coordenadas espaciales o
geograficas. En otras palabras, un SIG no solo funciona como una base de datos
convencional sino que posee capacidades especificas para gestionar datos
georreferenciados, como un conjunto de operaciones para trabajar con esos datos.

En cierto modo, un SIG es un mapa de un nivel superior o mas avanzado.”
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5. Metodologia

5.1 Descripcion general del area de estudio

5.1.1 Ubicacién y acceso
Segun el Plan de Ordenamiento Territorial (2019), el area de estudio, se encuentra

ubicada al Sur Oriente de la ciudad de Loja, a una distancia aproximada de 40 km.

Para efecto de la investigacion se utilizd el limite urbano perteneciente a la

parroquia Vilcabamba, que se encuentra delimitada por la unién de 12 puntos que

forman el poligono y presenta un area de 189 hectéareas.

El acceso al area de estudio por via terrestre partiendo desde el terminal terrestre

es a través de la avenidSi a Cuxibamba, avenida Manuel Agustin Aguirre y se dirige

hacia la avenida Eduardo Kingman, para luego llegar al redondel Angel Felicisimo

Rojas y continuar por E682 hacia Vilcabamba durante 40 minutos hasta llegar al area

de estudio

Figura 2.

Mapa de ubicacién del area de estudio
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La parroquia de Vilcabamba limita al norte con la parroquia San Pedro de
Vilcabamba; al sur con la parroquia Quinara y Yangana; al este con la provincia de

Zamora y; al oeste con el cantén Quilanga.

5.2 Materiales

5.2.1 Materiales de campo
+ GPS Garmin
* Libreta de campo
+ Fichas técnicas

« Camara fotografica

5.2.2 Materiales de oficina
+  Ortofotos
+ Software ArcGIS 10.8
- DEM

5.3 Métodos

Para el desarrollo de este proyecto se ha considerado utilizar diversos técnicas y
métodos como: el método descriptivo en el cual se caracteriza el area de estudio y los
objetos involucrados en el mismo, el método deductivo el mismo que permite descubrir
informacion desconocida a partir de informacién conocida y el razonamiento para
poder proyectar situaciones dentro del area de estudio a través de diversos factores
que se han presentado y que pueden influir posteriormente. El método analitico en el
cual se distinguen los diferentes elementos que abarca fendmenos o situaciones que
inciden en la ocupacion del suelo y se procede a revisar cada uno de ellos y su relacion
entre si. El método cientifico el cual realiza una secuencia de pasos para adquirir
conocimientos y se basa en el empirismo, medicion y estado sujeto a la razén.
También se utilizé como partida la observacion en el trabajo de campo, entre otros,
mismos que seran aplicados secuencialmente conforme el desarrollo de la
investigaciéon, con la finalidad de cumplir los objetivos planteados y determinar las

condiciones actuales del area de estudio.

5.4 Informacién preliminar
La recopilacion de informacion es el paso que da inicio al presente proyecto, siendo
este uno de los mas importantes, en el cual se compilado toda la informacién

bibliografica y cartografica necesaria para desarrollar el primer objetivo propuesto.
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Para la elaboracion del proyecto se ha utilizado la metodologia planteada por el
Consejo Técnico de Uso y Gestion del Suelo (2020), la cual presenta los lineamientos
que se deben tomar en cuenta para la determinacion de la ocupacion de suelo,
mediante recopilacion de informacion, levantamiento de datos in situ, interpretacion

de datos mediante el Sistema de Informacién Geografica.

De acuerdo a la LOOTUGS (2016) para un plan de uso y gestion de suelo es muy
importante contar con informacion base como lo es: el limite urbano existente, los
datos catastrales actualizados, mapas de valoracion de suelos, planes maestros de
infraestructura que abarcan aspectos como: vialidad, alcantarillados, energia eléctrica,
agua potable, asi como la distribucion de espacios publicos, equipamientos de salud,
educacion, sociales y areas verdes; el esquema de red vial y su respectiva
jerarquizacion, el sistema de movilidad, conectividad y transporte pablico. Otros datos
esenciales para integrar en el plan son la densidad poblacional en el territorio, entre

otros aspectos relevantes para un enfoque completo.

Con esta informacion preliminar se ha dado paso al desarrollo del diagnostico
urbano y para lo cual se ha realizado el reconocimiento del area de estudio a través
de observacién directa con el objetivo de verificar y actualizar datos acerca de
equipamientos, servicios bésicos, redes de infraestructura y posibles riesgos,

haciendo uso de fichas técnicas, registro fotografico y toma de puntos GPS.

Seguido de esto se procedié al trabajo de oficina el cual consiste en procesar e
interpretar la informacién obtenida para ser plasmados de forma grafica a través del

uso del software ArcGIS tomando en cuenta la normativa y las resoluciones vigentes.

5.5 Metodologia para el primer objetivo

“Actualizar el diagnéstico urbano de la cabecera parroquial de Vilcabamba”

El desarrollo del diagnostico no implico llevar a cabo un nuevo analisis completo del
diagnostico del canton como tal; se utilizé la informacion a partir del contenido del
PDOT vigente y se procedié a profundizar en el andlisis e interpretacién de datos a
una escala mas detallada. Se incorporaron recursos adicioales como el catastro
predial, levantamiento de informacion en situ, entre otros., con el fin de comprender

detalladamente las dinamicas locales presentes, y para su analisis incluye lo siguiente:
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5.5.1 Topografia

Para la elaboracion de este mapa, la informacion fue facilitada por el GAD municipal
de Loja, al ser un proyecto de interés mutuo; con dicha informacion se realizé el
reconocimiento in situ con el fin de interpretar e identificar las principales zonas, puntos

de referencia y la planificacion para el desarrollo del proyecto.
A partir de los datos obtenidos se realizo el siguiente proceso:

1. Se crea una base de datos en Excel, especificando las coordenadas X, Y, Z,
para luego ser importada desde ArcGIS estableciendo un Sistema de
Referencia Espacial en este, tomando la Zona 17S.

2. Se obtiene una vista 3D de la topografia del terreno mediante la generacion del
Modelo Digital del Terreno. Haciendo uso de la herramienta ArcToolbox > 3D
Analyst Tools > Data Mangement > TIN > Create TIN

3. Luego, se procede al Modelo Digital de Elevacién (DEM), el cual nos servira en
la generacion de las curvas de nivel, mediante polilineas, especificando el
intervalo deseado. Usando ArcToolbox > 3D Analyst Tools > Coversion > From
TIN > TIN to Raster.

4. Luego se dirige a ArcToolbox >3D Analyst Tools > Raster Surface > Contour.
Finalmente, para mejorar la precision se debe suavizar las curvas de nivel y se
digitaliza los componentes de la zona de estudio (red vial, red hidrica,
infraestructura, cobertura vegetal) lo cual se lo ejecuta a partir de la ortofoto.

ArcToolbox > Cartography Tools > Generalization > Smooth Line

5.5.2 Litologia
Para realizar el mapa litolégico se tomé como referencia la carta geoldgica de
Gonzanama a escala 1:100.000, del afio 2017 del Instituto de Investigacion Geoldgica.

A partir del mapa geoldgico regional se procedié con el levantamiento en campo a
través de fichas y fotografias de afloramientos tanto de origen natural, como antrépico
(corte de via e infraestructuras) y simultaneamente la extraccion de muestras para su

posterior analisis petrografico.

Al realizarse la fase de campo, se recorrid por todas las areas accesibles, con la

finalidad de obtener la informacidén necesaria para realizar la representacion litologica.
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Los afloramientos encontrados fueron georeferenciados en coordenadas UTM-
WGS84 Zona 17S y descritos en fichas de campo (Ver Anexo 1) con la ayuda de un
mapa topogréfico guia. Se plasma en el mapa todos los datos recopilados en campo,
caracteristicas para finalmente obtener el mapa litol6gico del area de estudio.

5.5.3 Pendientes
El mapa de pendientes se ha elaborado mediante el geoprocesamiento del Modelo
Digital del Terreno, en el cual se calcula la diferencia del gradiente en el relieve, es

decir se hace una relacion entre la distancia horizontal y la altitud entre dos puntos.
Para elaboracién del mapa se realizé el siguiente proceso:

1. Se generd la pendiente a través del uso de la herramienta Slope, que se
encuentra en Arctoolbox > Spatial Analyst Tools > Surface > Slope. En “Input”
se ingresa el modelo digital del territorio obtenido del SIGTIERRAS — IGM de
resoluciéon 1x1m por pixel y en “Output” se selecciona la direccion de
almacenamiento y su nombre respectivo.

2. Seguido de esto, se utilizdé la herramienta Reclassify, que se encuentra en
Arctoolbox > Spatial Analyst Tools > Reclass > Reclassify. Se ingresa el archivo
obtenido del proceso anterior; se procede a reclasificar los valores obtenido por
Default y se introduce los rangos de la clasificacion de pendiente propuesta por
el MAGAP (2012) la cual se encuentra clasificada en porcentaje como se

muestra a continuacion:

Tabla 1.
Clasificacion de la pendiente
Color Descripcién Rango (%)
Plana 0-2
Muy suave 2-5
Suave 5-12
Media 12-25
Media a fuerte 25-40
Fuerte 40-70
Muy fuerte 70 — 100
Escarpada 100 - 150
Muy escarpada 150 - 200
Abrupta >200

Nota: Catalogo de Objetos (MAGAP, 2012)
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+ Mediante la herramienta Raster to Polygon, se transforma el raster a vector,
esta se encuentra en Arctoolbox > Conversion Tools > From Raster > Raster to
Polygon. Al vector obtenido se le afiadi6 campos como: area y porcentaje, para
su posterior calculo.

+ Finalmente se generaliza cada una de las clasificaciones, es decir se construye
un solo poligono para cada clasificacion, para ello se utiliza la herramienta
Dissolve, que se encuentra en Data Management Tools > Generalization >
Dissolve, una vez construido se agrega atributos a su tabla tales como: clase,
rango, area, y porcentaje; y se asigna la coloracion respectiva para identificar a

cada una de las clasificaciones existentes.

5.5.4 Sectorizacion, amanzanamiento e identificacion predial
Para temas de planificacion, ya se tenia definida la zonificacion del area de estudio.
Por lo tanto, se ha elaborado de sectorizacion donde se muestra el limite urbano,

predios, red vial, red hidrogréfica y cada zona delimitada segun el plan regulador.

5.5.5 Redes de infraestructura

Para la actualizacion del diagnostico es vital el levantamiento de la infraestructura
fisica la cual da soporte a los servicios con los que cuenta la parroquia y abarcan:
agua potable, alcantarillado, energia eléctrica, alumbrado publico, redes viales, entre

otros.

Las redes de infraestructura fueron levantadas en campo a través de observacion

de predios en especifico.
Desde el punto de vista cualitativo y cuantitativo se realizo lo siguiente:

« Se graficaron en planos tematicos y se visualizé el trazado urbano y la
cobertura de acuerdo a lo observado

« Las mediciones o registro del nivel de servicios se procesaron grafica y
porcentualmente para cada zona, facilitando la lectura de las zonas con
déficit.

5.5.6 Equipamientos
Los equipamientos son de vital importancia para el desarrollo y consolidacion de la

parroquia, es por ello que se ha procedido a levantar cada uno para catalogarlo,
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analizarlo y describirlo. Para el levantamiento de los equipamientos, se hara uso de
fichas técnicas (Ver Anexo 2), para registrar los cambios observados directamente en

campo.

Una vez realizado la verificacion en campo se procede a establecer el radio de
influencia segun la tabla anexada propuesta por el Consejo Técnico de uso y gestion

del suelo. (Ver Anexo 3)

Para la realizacion del mapa de equipamientos, se ha ubicado geograficamente los
equipamientos existentes, se categoriz6 y describi6 las caracteristicas y el estado de
cada uno, para de esta forma prever instalaciones futuras para otros equipamientos
requeridos segun los estandares urbanisticos establecidos en cada cantén o los que

se establezcan a nivel nacional.

5.5.7 Area de patrimonio arquitecténico y cultural

El &rea de patrimonio arquitecténico y cultural se la ha definido en base al Inventario
del Instituto Nacional de Patrimonio Cultural (2018) y se lo ha verificado y actualizado
en campo a través de fotos y puntos GPS, para conocer su estado actual y con dicha
informacion se ha realizado la representacién grafica mediante un mapa mediante el

software ArcGIS.

5.5.8 Uso actual de suelo

El uso actual de suelo se ha realizado en base al articulo 32 de la Resoluciéon Nro.
005-CTUGS- 2020 donde menciona los destinos de los usos del suelo para los PUGS,
haciendo uso de su definicién y mediante el andlisis de las caracteristicas del area
urbana de estudio se clasificO de acuerdo a los tipos especificados en la siguiente
tabla.

En el trabajo de campo se ha identificado los diferentes usos de suelo para lo cual

se describe a continuacion la clasificacion y subclasificacion:
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Tabla 2.
Destinos de los usos del suelo
Clasificacion Subclasificacion
Residencial de baja densidad
Residencial de mediana
densidad
Residencial de alta densidad

Uso residencial

Uso comercial y de servicios

Uso mixto o multiple

Industrial de bajo impacto
Industrial de mediano impacto
Uso industrial
Industrial de alto impacto
Industrial de alto riesgo

Uso equipamiento
Uso de proteccién de Patrimonio
Historico y Cultural
Uso agropecuario
Uso forestal
Uso acuicola
Uso de proteccidn ecolégica
Uso de aprovechamiento extractivo

Uso de proteccion de riesgos

Nota: Fuente: (CTUG, 2020)

5.6 Metodologia para el segundo objetivo
“Catalogar la clasificacion y subclasificaciéon del uso de suelo de acuerdo a
la LOOTUGS”

5.6.1 Subclasificacion del Suelo

La subclasificacion del suelo se ha realizado de acuerdo a las definiciones
plasmadas en el articulo 18 de la Ley Organica de Ordenamiento Territorial, Uso y
Gestidon del Suelo en el gue menciona que para el suelo urbano se establece la

siguiente sub-clasificacion:

Suelo urbano consolidado.
*  Suelo urbano no consolidado.

* Suelo urbano de proteccion.
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Para la delimitacion del suelo urbano el GAD municipal, se ha considerado los
criterios que se disponen en la Resolucion Nro. 0012-CTUGS-2022 emitida por el
CTUGS en la cual consta los criterios técnicos para determinar el grado de

consolidacion que son:

« Primero se ha determinado el tipo deservicio y jerarquias para hallar el grado
de consolidacion del suelo urbano, clasificados de acuerdo a la disponibilidad
en esenciales y complementarios.

* Luego se analizaron los equipamientos esenciales que son: salud, educacion,
abasto y comercio, bienestar social, recreacion y areas verdes, seguridad,
administracion publica y transporte.

+ Seguido de esto, se identificaron los rangos de cobertura de cada uno de los
equipamientos esenciales, el ambito de aplicacién, escala y su radio de
influencia.

« Por dltimo, se analiz6 el grado de ocupacion que corresponde al porcentaje de
predios ocupados con cualquier edificacion que presente un asentamiento
humano concentrado en cada manzana o el poligono de delimitacién.
Considerando los siguientes porcentajes:

o Alto grado de ocupacion, igual o mayor al 75% del total de predios.
o Mediano grado de ocupacion, entre el 25% y el 74% del total de predios.

o Bajo grado de ocupacion, menor al 25% del total de predios.

Mediante el andlisis de estos puntos se pudo definir si el suelo urbano consolidado
a partir de la provision de servicios y el grado de ocupacién de los asentamientos
humanos en cada poligono de intervencion, realizando posterior a ello el trazo en el
limite urbano, de igual forma se definio el suelo urbano no consolidado en areas donde
no existen todos los servicios e infraestructura esencial y también se identifico los
suelos urbanos de proteccion que pueden encontrarse dentro de los suelos urbanos
consolidados, asi como de los no consolidados, para lo cual los PDOT municipales y
PUGS se deben acoger a lo estipulado por entes rectores nacionales en materia
ambiental, patrimonial, de riesgos, estableciendo la ubicacion, areas de influencia y

dimensionamiento en base a las disposiciones de estos entes.
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5.7 Metodologia para el tercer objetivo

“Elaborar mapa de ocupacion de suelo del area de estudio”

El andlisis de nivel de ocupacion de suelo permite comparar los rendimientos del

suelo urbano, con el aprovechamiento actual del suelo, para ello se ha cumplido lo

estipulado por la a Resolucion Nro. 0012-CTUGS-2022 articulos 14-15, que emite lo

siguiente:

1. Analizar las regulaciones de ocupacion de suelo vigentes en el GAD Municipal

2. Considerar los datos catastrales o de levantamientos en campo, en caso de no

tener informacioén actualizada:

a.
b.

Caddigo de manzana

Area de la manzana en m2, sin tomar en cuenta superficie de acera y
calzada.

Numero de predios por manzana

Area edificada en planta baja (m2): se toma en cuenta Unicamente la
superficie que la edificacion ocupa sobre el suelo

Coeficiente de Ocupacién de Suelo: este dato se encuentra en la norma

urbanistica de cada cantdn y se expresa en porcentaje o indice.

3. Analizar la forma de ocupacion del suelo

Una vez obtenida la informacién mencionada, para la determinacion del nivel de

ocupacion de suelo se realiz6 el siguiente proceso:

1. Determinar el area edificable: es el area que resulta de multiplicar el area de

manzana en m2, por el coeficiente de ocupacion asignado a la manzana.

Area edificable = &rea de manzana (m2) * COS(PB)

2. Determinar el nivel de Ocupacion: es la relacidon que permite cuantificar cuanto

del area permitida a ocupar sobre el suelo, esta realmente ocupada. Este

calculo considera como 100% el area a edificar y calcula el porcentaje que

corresponde al area edificada u ocupada.

Nivel de ocupacion = area edificada *» 100 area edificable

3. Determinar el area vacante: permite dimensionar el area de ocupacion

disponible. Este célculo se realiza entre el area edificada de planta baja y el

area edificable.

21



Area vacante = area edificable (m2) — area edificada (m2)

El resultado del proceso de la determinacién de la ocupacion de suelo, puede

detallarse conforme la siguiente tabla:

Tabla 3.

Resumen del proceso de ocupacién de suelo

Cadigo Area Area Nivel de Area
Area Predios edificabl | ocupacié vacant
Manzana edificada | COS PB ePB nde ePB
Se Manzana Total PB suelo
asignara
el codigo
respectivo m2 m2 m2 m2

Nota: Fuente: (CTUGS, 2022)

5.7.1 Ocupacion del Suelo
Para la ocupacion del suelo se ha considerado varios criterios como altura,

dimensiones, forma de edificacion, retiros y otras variables de tipo morfolégicos.

Una vez calculado todos los parametros mencionados anteriormente se ha
establecido rangos de ocupacion que permitan agrupar zonas urbanas por
homogeneidad, para lo cual se propone una clasificacion estructurada de la siguiente
forma.

Tabla 4.

Clasificacién basica de rangos de ocupacion de suelo

Cdbdigo de color Rango de ocupacion Categoria

0—-25%
26% - 50%

Formacion
Conformacion

51% - 75% Complementacion

76% - 100% Consolidacion

> a 100% Sobreocupacién

Nota: Fuente: (PUGS, 2020).
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6. Resultados

6.1 Resultados del primer objetivo

6.1.1 Diagnéstico Urbano de la cabecera parroquial

6.1.1.1 Delimitacién urbana

Segun la Recopilacion Codificada de la Legislacion Municipal de Loja (2015), la
delimitacion del area urbana de la parroquia Vilcabamba se rige por las disposiciones
establecidas en el COOTAD, especificamente en su Articulo 57, Literal z. Este articulo
atribuye al concejo municipal la facultad de regular, a través de ordenanzas, la
demarcacion de barrios y parroquias urbanas, tomando en consideracion la
configuracion territorial, identidad, historia, necesidades urbanisticas y
administrativas. En este contexto, la delimitacion del area urbana de la parroquia

Vilcabamba se realiza de la siguiente manera (Ver Anexo 4):

NORTE: Iniciando desde el punto P1, situado en la interseccion de las coordenadas
N9528900 y la margen de proteccion de la quebrada (15 mts.), en direccién Noroeste
hasta alcanzar el punto P2 ubicado en la interseccion de las coordenadas N9529100
y E698000. Luego, continta a lo largo del margen norte de la quebrada aguas abajo
hasta llegar al margen este de proteccion del rio Chamba. Se sigue aguas abajo por
el margen del rio Chamba hasta el punto P3, ubicado en la interseccion del margen
del rio Chamba y la coordenada E697000.

SUR: Partiendo desde el punto P6 en direccién Este y siguiendo la coordenada
hasta llegar al punto P7, ubicado en la interseccién de la coordenada N9528100 y el
margen este de proteccion de la quebrada Puliche. ContinGa en direccién Norte a lo
largo del margen de proteccién de la Quebrada Puliche aguas abajo hasta llegar al
punto P8, situado en la interseccion del margen este de la quebrada Puliche y la
coordenada N9528800. Prosigue en direccion Este, siguiendo la coordenada hasta
llegar al punto P9, ubicado en la interseccion entre el margen de proteccion oeste del
rio Chamba y la coordenada N9528800. Luego, sigue a lo largo del margen de
proteccion del rio Chamba aguas arriba hasta llegar al punto P10, ubicado en la
interseccion de los margenes del rio, al oeste del rio Chamba y el margen este de la

quebrada seca sin nombre.

ESTE: Desde el punto P10, sigue a lo largo del margen oeste de proteccién de la

guebrada seca sin nombre aguas arriba hasta llegar al punto P1.
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OESTE: Partiendo desde el punto P3 hacia el sur, se debe seguir la coordenada
hasta llegar al punto P4, ubicado en la interseccion de las coordenadas N9528900 y
E697000. Continda en direccion suroeste hasta llegar al punto P5, ubicado en la
interseccion de las coordenadas N9528600 y E696700, y luego contintia en direccion
sur hasta llegar al punto P6, ubicado en la interseccion de las coordenadas N9528100
y E696700.

6.1.1.2 Litologia
Para la confeccion del mapa litolégico, se hizo uso de la informacion suministrada
por el GAD Municipal de Loja. En este contexto, la labor de campo se orientd hacia la
descripcion detallada de los afloramientos con el propdésito de recopilar datos

litoldgicos de las diversas formaciones, validando asi la informacion preexistente.

La observacion de afloramientos se vio obstaculizada por la cobertura del suelo y
las estructuras edificadas debido a que es un éarea urbana. A pesar de estas
dificultades, se pudo determinar que la mayor extension estd compuesta
principalmente por depositos aluviales, que es donde se asienta el &rea urbana de la
parroquia. En la parte oriental, se identifica la presencia de la Unidad Chigiinda, que
forma parte del basamento y estd compuesta por rocas metamaorficas. En contraste,
en la zona occidental, se observan depdésitos coluviales procedentes de formaciones
ubicadas en elevaciones mas altas. (Ver Anexo 5)

Unidad Chiglinda

Figura 3.

Afloramiento Unidad Chiguinda

Esta unidad geoldgica se manifiesta en la parte oriental del area de estudio,

constituyendo el basamento y caracterizandose por la presencia predominante de
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rocas metamorficas de bajo grado, especialmente esquistos sericiticos. Estos ultimos
prevalecen en abundancia en esta region y exhiben tonalidades rojizas debido a las
oxidaciones de hierro, asi como variados matices de grises y verdes, siendo estos
ultimos el resultado de la recristalizacion de la clorita. Ademas, se observa la presencia

de cuarcita en proporciones menores, destacando por su color blanco grisaceo.
Depdsitos Coluviales

Figura 4.

Depdsitos Coluviales via a Yamburara

Los depdsitos coluviales, identificados en las proximidades de los aluviales en el
piedemonte, se generan a través de procesos de alteracion in situ de las rocas
localizadas en las laderas superiores. Estos depdsitos exhiben una disposicion
desordenada de clastos de diversos tamafios, compuestos mayormente por rocas

metamorficas como filitas y esquistos, los cuales presentan formas angulares y
subangulares.

Depdsitos Aluviales

Figura 5.

Depositos aluviales a lo largo del Rio Chamba
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Los depdsitos aluviales se encuentran rio Chamba que pasa por el centro del area.
Estos depdsitos se componen de cuerpos medianamente consolidados que se
extienden considerablemente. Morfolégicamente, se caracterizan como terrazas
aluviales, incorporando una variedad de materiales como arenas, gravas, limos y
elementos redondeados, como cantos y bloques, mayoritariamente de origen

volcanico y metamorfico.

6.1.1.3 Pendientes

A través del uso del software ArcGis 10.5 y mediante el procesamiento de la
topografia (Ver Anexo 8) del modelo digital de elevacion se generé un mapa de
pendientes del area de estudio, haciendo uso de la clasificacién establecida por el
MAGAP (2012), dando como resultado diez clases de pendientes, con su respectiva

area y porcentaje como se detalla a continuacioén:

Tabla 5.
Pendientes del 4rea urbana del area de estudio
Color Descripcion Rango (%) Area (Ha) Porcentaje (%)
Plana 0-2 8.69 4.63
Muy suave 2-5 39.15 20.84
Suave 5-12 71.02 37.81
Media 12-25 38.67 20.59
Media a fuerte 25-40 15.09 8.03
Fuerte 40-70 11.57 6.16
Muy fuerte 70 — 100 3.41 1.82
Escarpada 100 - 150 0.24 0.13
Muy escarpada 150 — 200 0.00 0.00
Abrupta >200 0.00 0.00

Nota: Fuente: (PUGS, 2020) Actualizado por: La autora, 2024

Segun los valores recabados, se evidencia que en la cabecera parroquial
prevalecen las "pendientes suaves"”, abarcando un 37.81% del area de estudio. Le
siguen las pendientes "muy suaves" y "medias”, con porcentajes similares del 20.84%

y 20.59%, respectivamente.

A continuacién, se encuentran las pendientes "media a fuerte”, "fuerte" y "plana”,
cada una con porcentajes de 8.03%, 6.16% y 4.63%, respectivamente, todos

inferiores. Asimismo, se han identificado pendientes "muy fuertes" y "escarpadas" con
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porcentajes minimos de 1.82% y 0.13%, respectivamente, siendo este ultimo apenas

perceptible en el area de estudio.

Es relevante destacar que, dentro del limite urbano, las pendientes con rangos
entre el 2% y el 25% predominan, mientras que las pendientes superiores al 25%
hasta el 150% se presentan en menor proporcion. Es importante mencionar que no se
han observado pendientes "muy escarpadas" y "abruptas" dentro de los limites

urbanos.

6.1.1.4 Sectorizacion, amansamiento e identificacion predial
Para un mejor estudio del limite urbano, el proyecto se ha estructurado en tres
zonas, cada una de ellas con un numero especifico de sectores. La zona 1 consta de
4 sectores, la zona 2 abarca 7 sectores y la zona 3 comprende 6 sectores. (Ver Anexo
9). El area total del entorno urbano en la cabecera parroquial de Vilcabamba abarca

189.86 hectéreas, distribuidas de la siguiente manera:

Tabla 6.

Sectorizacion del area de estudio

Cédigo Area (Ha) Porcentaje (%)
Z3S6 18.78 9.89
Z2S3 8.52 4.49
Z2S4 9.37 4.94
Z2S7 11.39 6.00
2256 6.79 3.58
Z2S5 4.59 2.42
Z1S1 10.49 5.52
Z1S2 18.89 9.95
Z3S4 10.41 5.48
Z1S4 10.05 5.29
Z2S1 6.89 3.63
Z1S3 10.54 5.55
2252 1.23 0.65
Z3S1 10.93 5.76
Z3S5 9.73 5.13
Z3S2 8.93 4,70
Z3S3 4,96 2.61

TOTAL 189.86 100

Nota: Fuente: (PUGS, 2020) Actualizado por: La autora, 2024
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6.1.1.5 Capa de rodadura
Vilcabamba, ubicada a 33 km, tiene como acceso principal la via que conecta Loja
con Vilcabamba, conocida como VI Eje vial, que se extiende hasta Zumba. Ademas,
cuenta con otro acceso desde el canton Catamayo: Tambo — Ceibopamba y

Malacatos.

En la cabecera parroquial, se destaca un notable porcentaje de vias asfaltadas, lo
que contribuye a una organizacion econdémica eficiente y facilita el desarrollo de

actividades locales. (Ver Anexo 10)

Tabla 7.

Capa de rodadura del &rea de estudio

Rodadura Area (Km) Porcentaje (%)
Adoquin 2.56 9.69
Empedrado 0.85 3.22
Asfalto 10.81 40.95
Lastre 9.04 34.26
Tierra 3.13 11.88
TOTAL 100

Nota: Fuente: (PUGS, 2020) Actualizado por: La autora, 2024

El andlisis del inventario sobre la capa de rodadura de las vias revela que
predominan aquellas con asfalto, representando el 40.95% con una extension de
10.81 km. En segundo lugar, se encuentran las vias con capa de rodadura de lastre,

abarcando un 34.26% y se extiende por 9.04 km dentro del limite urbano.

Por otro lado, las vias con adoquin constituyen el 9.69% que representa 2.56 km,
concentradas especialmente en un tramo cercano a la Iglesia y parque central.
Posteriormente, se identifican las vias con capa de rodadura en tierra, representando
el 11.88% del area de estudio, y, por ultimo, la via de acceso a la cabecera parroquial,
gue presenta una capa de rodadura de empedrado con un 3.22% que cubre 0.85 km
del area, siendo esta la capa de rodadura con menor extension y que se puedo

observar a simple vista en el acceso principal de la parroquia.

6.1.1.6 Espacios Publicos y Areas Verdes
En la zona urbana de la parroquia Vilcabamba, se ha identificado areas de

proteccion que abarcan aproximadamente 21.8 hectareas, tomando en cuenta
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margenes de proteccion del rio Capamaco y la quebrada Puliche, asi como las areas

verdes existentes.

En cuanto a los espacios publicos, la zona urbana de la parroquia Vilcabamba
cuenta con el parque central, el parque La Madre y diversas areas verdes distribuidas
por toda la cabcera parroquial. Segun el inventario del centro parroquial, se dispone
de 4.89 hectéreas de areas verdes. Segun las proyecciones del INEC para el afio
2020, con una poblacion de 2,507 habitantes, la relacion area verde/habitante es de
4.97 m2/hab. Este indice se sitia por debajo del limite recomendado por la OMS/OPS,
gue oscila entre 10 m2/hab y 15 m2/hab. (Ver Anexo 11)

6.1.1.7 Redes de infraestructura
Agua Potable: El 68.66% de los predios ubicados dentro del area urbana de la
parroquia Vilcabamba cuentan con agua potable de acuerdo al trabajo de campo

realizado. Es decir que, de 1171 predios, 804 cuentan con este servicio basico

En relacién con el servicio de Infraestructura Basica, se ha identificado un total de
10 captaciones de agua que abastecen a toda la parroquia, distribuidas 9 dentro de la
parroquia y 1 en la parroquia Quinara. De estas captaciones, 8 toman agua

directamente del rio, una utiliza el canal y otra se abastece mediante bombeo.

En cuanto al método de captacion, nueve se realizan por gravedad y una a traves
de una instalacién forzada. Segun el estado de conservacion, tres se encuentran en
buen estado, mientras que las siete restantes presentan un estado regular. (Ver
Anexo 12)

Tabla 8.
Cobertura de agua potable
Predios Agua Potable %
804 Sl 68.66
367 NO 31.34
1171 TOTAL 100

Nota: Fuente: (PUGS, 2020) Actualizado por: La autora, 2024

Alcantarillado: El servicio de alcantarillado en la zona urbana de la parroquia
Vilcabamba esta proporcionando cobertura a 758 predios, lo que representa el 64.73%

del total de predios, segun la recopilacion de datos realizada en campo. Es decir, que
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mas del 30% de la poblacién no cuentan con un adecuado alcantarillado. (Ver Anexo
13)

Tabla 9.
Cobertura de alcantarillado
Predios Alcantarillado %
758 Sl 64.73
413 NO 35.27
1171 TOTAL 100

Nota: Fuente: (PUGS, 2020) Modificado por: La autora, 2024

Energia Eléctrica: EI 92.40% de los predios dentro del limite urbano de la cabecera
parroquial, es decir 1082 predios cuentan con suministro de energia eléctrica
proporcionado por la Empresa Eléctrica Regional del Sur. Ademas, hay lineas de alta

tension a lo largo de la via principal y las colectoras. (Ver Anexo 14)

Tabla 10.

Cobertura de energia eléctrica

Predios Energia Eléctrica %
1082 Sl 92.40
89 NO 7.60
1171 TOTAL 100

Nota: Fuente: (PUGS, 2020) Actualizado por: La autora, 2024

6.1.1.8 Equipamientos de la cabecera parroquial
El equipamiento en la parroquia de Vilcabamba, clasificado segun la naturaleza de
las actividades que se desarrollan, se distribuye en diversos grupos, entre ellos (Ver
Anexo 15):

Educacién: En el area urbana de la parroquia Vilcabamba, se encuentran 5

establecimientos educativos.

a) Centro de Educacion inicial: categorizado como Tipologia Barrial, tiene un
radio de influencia de 400 metros, tiene capa de rodadura asfaltada y sus

instalaciones se encuentran en buen estado,
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Figura 6.

Centro educativo inicial Jardin

b) Escuela Fiscal Mixta Juan Montalvo: clasificada como Tipologia Barrial, con
radio de influencia de 400 metros. Se encuentra en excelente estado su
infraestructura, posee una capa de rodadura de asfalto y todos los servicios

basicos.

Figura 7.
Escuela Fiscal mixta Juan Montalvo

c) Instituto de Secundaria 13 de abiril: clasificado como Tipologia local, con un
radio de influencia de 1000 metros. Se encuentra en la parte céntrica y su
capa de rodadura es de adoquin. Su infraestructura se encuentra en buenas

condiciones aptas para el servicio a la comunidad.
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Figura 8.

Instituto de secundaria, 13 de abril

d) Colegio de bachillerato Vilcabamba: clasificado como Tipologia Sectorial,
con un radio de influencia de 400 metros. Tiene una accesibilidad buena en

asfalto y el estado de la estructura es muy bueno.

Figura 9.
Colegio de bachillerato Vilcabamba

La parroquia Vilcabamba alberga cuatro instituciones educativas distribuidas de la
siguiente manera: dos dedicadas a la educacion inicial y otras dos destinadas al
bachillerato. Todos estos establecimientos estan dotados de vias de acceso y
servicios basicos, y se ha observado que sus infraestructuras se encuentran en

Optimas condiciones.
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Recreacion y Deporte: La comunidad dispone del Parque Central, Coliseo
municipal, el Parque La Madre y una cancha deportiva como espacios destinados a

actividades recreativas y de esparcimiento.

a) Parque central: Este lugar es uno de los mas concurridos por habitantes del
lugar y turistas, se ubica en la parte céntrica del area urbana y presenta una

capa de rodadura de adoquin.

Figura 10.

Parque central de Vilcabamba

b) Parque de La madre: Este equipamiento se sitia a un costado de la via
principal hacia Vilcabamba, su accesibilidad se caracteriza por contar con

una capa de rodadura de asfalto y esta situado al norte del area urbana.

Figura 11.

Parque de "La Madre"
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c) Coliseo municipal: Este centro recreacional esta situado en la parte sur del
area de estudio y su via de acceso esta pavimentada con asfalto. Se ha

mejorado el entorno fisico mediante el adecentamiento de las areas verdes.

Figura 12.

Coliseo Municipal

d) Cancha Deportiva: El equipamiento fue recientemente construido y se
encuentra en la parte sureste de la cabecera parroquial. Refleja la deficiencia

en la accesibilidad vial y el poco mantenimiento a las redes de conectividad.

Figura 13.

Cancha Deportiva
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Culto: Dentro de esta categoria esta la iglesia principal de origen catdlico, que se
encuentra frente al parque central de la cabecera parroquial. Sus vias de acceso
cuentan con una capa de rodadura de adoquin.
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Figura 14.

Iglesia Vilcabamba

Salud: La importancia del Hospital Basico de Vilcabamba radica en su papel como
centro de atencion adscrito al Ministerio de Salud Publica. Su ubicacion estratégica en
una zona con accesibilidad vial y servicios bésicos es fundamental para facilitar la
disponibilidad de atencion médica de calidad. Las instalaciones muestran una buena

condicion y presenta un ambiente adecuado para la atencion médica.

Figura 15.

Centro de salud de Vilcabamba

Administracion Puablica: La presencia de equipamientos de gestion en la
Parroquia desempefia un papel crucial para facilitar y agilizar actividades
administrativas, de gestion y servicios. La existencia de estos equipamientos de

gestiébn muestra la disposicion de los servicios a la comunidad.
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Figura 16.

Centro administrativo y casa comunal

Transporte: El area de estudio consta de un equipamiento de transporte que se
encuentra detrds del mercado parroquial. El acceso a este equipamiento es de
adoquin.

Figura 17.
Terminal terrestre de Vilcabamba

Abasto: Respecto al equipamiento de abastecimiento, el Mercado Parroquial esta
bajo la administracién del GAD y abarca una superficie de 3018.46 m2, donde se
ubican locales de venta tanto internos como externos, asi como locales dedicados a

la venta de alimentos.
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Figura 18.

Mercado Central de Vilcabamba

Inclusion Social: El area de estudio consta de 2 centros de inclusion social que

son: El centro del adulto mayor y el centro gerontoldgico.

a) Cetro del Adulto Mayor: El centro del adulto mayor se encuentra en la parte
oeste del area y brinda una atencion integral para personas mayores de 65
afos. El acceso a este equipamiento es de asfalto y las instalaciones se

encuentran en perfectas condiciones.

Figura 19.

Estancia Municipal del Adulto Mayor

b) Centro Gerontolégico del Adulto Mayor: El centro gerontologico también
brinda sus servicios a las personas mayores de 65 afos. Se encuentra
ubicado a la entrada de la parroquia en la via principal, su acceso tiene una

capa de rodadura de asfalto y las instalaciones tienen un excelente estado.
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Figura 20.

Centro Gerontologia del Adulto Mayor

Seguridad Publica: La cabecera parroquial dispone exclusivamente de una
Unidad de Policia Comunitaria (UPC). La clasificacion de esta unidad como de
tipologia barrial demuestra la falta de alineacion con las caracteristicas y necesidades
especificas de la comunidad local. En consecuencia, la presencia de la UPC refleja

las deficiencias estratégicas para abordar las particularidades de seguridad del area.

Figura 21.
UPC de Vilcabamba

6.1.1.9 Area de patrimonio arquitecténico y cultural

La elaboracion del mapa de Patrimonio arquitecténico y cultural se basa en una
verificacion en campo, para la cual se ha utilizado el inventario proporcionado por el
Instituto Nacional de Patrimonio Cultural (INPC) del afio 2018. Este proceso ha

permitido evidenciar la presencia de 39 edificaciones que presentan un valor
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patrimonial significativo. La atencion se ha centrado no solo en identificar estas
estructuras, sino también en verificar su ubicacion y evaluar el estado actual de cada

una de ellas. (Ver Anexo 17)

Tabla 11.

Inventario del INPC del area de estudio

Nro. Denominacion Régimen  Afio Tipologia
1 Casona Privado 1920 Arquitectura popular o vernacula
2 Casa Privado 1890 Arquitectura popular o vernacula
3 Casa Privado 1890 Arquitectura popular o vernacula
4 Casa Privado 1940 Arquitectura popular o vernacula
5 Casa Privado 1940 Arquitectura popular o vernacula
6 Casa Privado 1940 Arquitectura popular o vernacula
7 Casa Privado 1890 Arquitectura popular o vernacula

Tempilo cristo luz del ) ) o
Privado 1860  Arquitectura monumental religiosa

mundo

9 Plaza central Privado 1965 Plazas

10 Casa Privado 1940 Arquitectura popular o vernacula
11 Casa Privado 1890 Arquitectura popular o vernacula
12 Casa Privado 1850 Arquitectura popular o vernacula
13 Casa Privado 1940 Arquitectura popular o vernacula
14 Casa Privado 1945 Arquitectura popular o vernacula
15 Casa Privado 1930 Arquitectura popular o vernacula
16 Casa Privado 1910 Arquitectura popular o vernacula
17 Casa Privado 1960 Arquitectura popular o vernacula
18 Casa Privado 1910 Arquitectura popular o vernacula
19 Casa de hacienda ‘el Privado 1920 Haciendas

atillo'

20 Vivienda Privado 1950 Arquitectura popular o vernacula
21 Vivienda Privado 1940 Arguitectura popular o vernacula
22 Vivienda Privado 1850 Arquitectura popular o vernacula
23 Vivienda Privado 1950 Arquitectura popular o vernacula
24 Vivienda Privado 1960 Arquitectura popular o vernacula
25 Vivienda y comercio Privado 1930 Arquitectura popular o vernacula
26 Vivienda y comercio Privado 1960 Arquitectura popular o vernacula
27 Vivienda Privado 1958 Arquitectura popular o vernacula
28 Vivienda Privado 1966 Arquitectura popular o vernacula
29 Vivienda Privado 1948 Arquitectura popular o vernacula
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Vivienda y radio ] )
30 ] Privado 1950 Arquitectura popular o vernacula
Vilcabamba Stereo

31 Vivienda Privado 1925 Arguitectura popular o vernacula
32 Edificacién desocupada Privado 1950 Arquitectura religiosa

33 Vivienda Privado 1958 Arquitectura popular o vernacula
34 Vivienda y comercio Privado 1963 Arquitectura popular o vernacula
35 Vivienda Privado 1910 Arquitectura popular o vernacula
36 Edificacién desocupada Privado 1925 Arquitectura popular o vernacula
37 Vivienda Privado 1950 Arquitectura popular o vernacula
38 Vivienda Privado 1910 Arquitectura popular o vernacula
39 Vivienda Privado 1970 Arquitectura popular o vernacula

Nota: INPC (2018)

6.1.1.10 Uso suelo actual
En esta variable se ha observado que al igual que en cualquier estructura urbana,
las actividades comerciales y de gestion tienden a concentrarse en el nacleo central
de la zona de estudio. En Vilcabamba, esta dindmica se manifiesta, presentandose
junto con el uso de “vivienda” conformando el uso “mixto” debido al tamafio reducido

de la poblacion. (Ver Anexo 18)

Tabla 12.

Uso actual del suelo del area de estudio

Uso NUumero de Predios Porcentaje
Equipamiento 16 1.37
Comercial 24 2.05
Mixto 110 9.39
Vacante 149 12.72
Vivienda 872 74.77
TOTAL 1171 100

Nota: Fuente: (PUGS, 2020) Modificado por: La autora, 2024

El analisis detallado del uso actual del suelo ha mostrado patrones significativos en
la distribucién de las actividades urbanas en la parroquia. El predominio del uso
"vivienda", que representa 70.77% del area urbana, destaca el predominante uso de
“‘vivienda” en la zona. A este le sigue el uso "vacante" con un 16.84%, indicando areas

gue actualmente no estan siendo utilizadas o desarrolladas.

Adicionalmente, el uso "mixto" se presenta de manera dispersa en toda el area

parroquial urbana, mostrando una combinacion de diferentes actividades en diversas
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ubicaciones. Por ultimo, el uso de "equipamiento” abarca el 1.71%, sefialando areas

destinadas a servicios y equipamientos publicos.

Estos resultados proporcionan una informacion integral de la distribucién actual del
espacio urbano. La prevalencia de la vivienda y la presencia de areas vacantes indican
oportunidades potenciales para el crecimiento y la optimizacion del uso del suelo,
mientras que la existencia de zonas mixtas y de equipamiento resalta la diversidad

comercial, econdmica y dinamismo de la comunidad. (Ver Anexo 19)

6.2 Resultados del segundo objetivo
6.2.1 Subclasificacion de Suelo

Para determinar la subclasificacién del suelo, se debe determinar el grado de
consolidacion del suelo urbano, para ello se ha tomado en consideracion los siguientes

criterios técnicos:
e Tipo de servicio

En el area de estudio se ha verificado el tipo de servicios con los que se cuenta, su
jerarquia y el ambito de aplicacién. Dentro de los servicios esenciales se obtuvo:

dotacién de agua potable, cobertura de alcantarillado y servicio de energia eléctrica.

Y en servicios complementarios se observaron: sistema de iluminacion de vias y
espacios publicos, telefonia fija, sefalizacién publica, telefonia movil, internet

inalambrico, entre otros.
e Equipamientos esenciales

Los servicios esenciales a los que la poblacion acude en el area de estudio son
salud, educacion, abastecimiento, inclusion social, recreacion, deporte, seguridad,
transporte, entre otros. Para evaluar la consolidacion de estos servicios, es crucial
comprender la cobertura, el alcance y la aplicacion de los equipamientos. Por esta
razon, se considera la informacion recopilada durante el diagnostico de los

equipamientos.
e Grado de ocupacién

El grado de ocupacion se realizé mediante el analisis por sectorizacion del area de

estudio, en el cual se obtuvo los siguientes datos:
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Tabla 13.

Grado de ocupacion por sectores

Sector Grado de Tipo Tipo de suelo
ocupacién
Z1S1 98.12 Alto grado de ocupacion. Suelo Urbano Consolidado
Z1S2 90.76 Alto grado de ocupacion. Suelo Urbano Consolidado
Z1S3 88.10 Alto grado de ocupacion. Suelo Urbano Consolidado
7154 77.70 Alto grado de ocupacion. Suelo Urbano Consolidado
Z2S1 100.00 Alto grado de ocupacion. Suelo Urbano no Consolidado
Z2S2 100.00 Alto grado de ocupacion. Suelo Urbano no Consolidado
Z2S3 69.39 Mediano grado de ocupacion Suelo Urbano no Consolidado
2254 76.98 Alto grado de ocupacion. Suelo Urbano no Consolidado
Z2S5 88.37 Alto grado de ocupacion. Suelo Urbano no Consolidado
7256 50.00 Mediano grado de ocupacion Suelo Urbano no Consolidado
Z2S7 100.00 Alto grado de ocupacion. Suelo Urbano no Consolidado
Z3S1 66.67 Mediano grado de ocupacion Suelo Urbano no Consolidado
Z3S2 83.33 Alto grado de ocupacion. Suelo Urbano no Consolidado
Z3S3 97.06 Alto grado de ocupacion. Suelo Urbano no Consolidado
2354 90.00 Alto grado de ocupacion. Suelo Urbano no Consolidado
Z3S5 100.00 Alto grado de ocupacion. Suelo Urbano no Consolidado
Z3S5 47.37 Mediano grado de ocupacion Suelo Urbano no Consolidado

Como resultado se obtuvo que, los cuatro sectores de la Zona 1 presentan un alto
grado de ocupacion, superando el 75%. Esta area corresponde al nucleo central de la
cabecera parroquial. Por otro lado, en los sectores de la Zona 2 y 3, se observa un
grado de ocupacion variado entre mediano y alto grado de ocupacion, con algunos
sectores exhibiendo niveles medianos (entre el 25% y el 75%). Este cambio se
atribuye a la presencia de numerosos predios vacios y a la falta de equipamientos,

factores que han impedido la consolidacion plena de estas areas.

6.2.1.1 Suelo Urbano Consolidado
El suelo urbano consolidado en la cabecera parroquial forma una mancha urbana
continua que ha ido creciendo a los alrededores y en conjunto con la via principal y el
parque. Esta distribucion denota una planificacion y desarrollo que se ha priorizado la
conectividad y la centralidad como base del desarrollo. La presencia de servicios
basicos en esta area consolidada es fundamental, ya que contribuye a la habitabilidad

y al funcionamiento eficiente de la parroquia.
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La dinamica de la zona se ve enriquecida por la diversidad de usos comerciales
presentes, indicando un alto nivel de actividad econémica y social. Esta area cubre los
4 sectores de la zona 1 es decir todo el casco céntrico del area de estudio. La
ubicacion estratégica cerca de la via principal y el parque central confirma la
importancia de estos elementos en la estructura urbana. En resumen, la mancha
urbana consolidada indica una planificacion efectiva y un desarrollo que prioriza la
conectividad, la centralidad y la diversidad econdmica y comercial para fomentar un

entorno urbano activo y dinamico.

6.2.1.2 Suelo Urbano No Consolidado

El suelo urbano no consolidado se extiende en las periferias del area del suelo
urbano consolidado y revela que no se ha desarrollado significativamente, a pesar de
estar dentro del perimetro urbano. Se manifiesta abarcando una ocupacion del suelo
superior al 50% por lo que es el tipo de suelo mas predominante en el area de estudio.
Adicionalmente, carece de algunos sistemas de soporte esenciales para la
habitabilidad del area. Las condiciones topogréficas también han influido en la
limitaciébn del desarrollo, mostrando un crecimiento disperso con pequefas

concentraciones de viviendas.

El suelo urbano no consolidado representa un area donde la planificacion y la
gestién pueden expandirse plenamente, excluyendo aquellas areas no urbanizables

tales como el area del suelo de proteccién para evitar futuros desastres.

Estas areas no consolidadas abarcan un total de 110.20 hectéreas, lo cual equivale
al 58.05% del &rea total, mostrando la significativa extension de suelo que aun falta

desarrollar.

Servicio de Agua Potable: En el &mbito urbano, la cobertura del servicio de agua
potable abarca gran parte del area edificada, alcanzando una cobertura del 68.66%,
sin embargo, sigue siendo necesario extender la cobertura completamente dentro del
perimetro urbano. Es importante tomar medidas estratégicas para la mejora en los
sistemas publicos de soporte y las redes de infraestructura para el desarrollo y

consolidacion del area.

Servicio de Alcantarillado: La cobertura de alcantarillado en la zona urbana

alcanza el 64.73% Actualmente, se enfrentan problemas en el sistema de
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alcantarillado, y es importante tomar accion frente a estas deficiencias y desafios

presentes en el sistema de aguas residuales.

Es imperativo mejorar los sistemas publicos de soporte, las redes de infraestructura

y equipamientos en ambas areas de servicios publicos.

6.2.1.3 Suelo Urbano de Proteccion
En la delimitacion del suelo urbano de proteccion de Vilcabamba, se han
considerado los criterios ya establecidos por los técnicos del GAD Municipal en los
cuales se toma en cuenta algunas variables importantes. Dentro de estos parametros,
se presta especial atencion a las areas ubicadas en los margenes de rios y quebradas,
dado que representan zonas de riesgo inadecuadas para la construccion debido a
posibles inundaciones o desbordamientos de rios o quebradas.

Asimismo, se toma en cuenta la pendiente del terreno, especialmente aquella que
supera el 40%, ya que la topografia, la gravedad y las actividades humanas a las que
estas areas estdn expuestas podrian desencadenar problemas potenciales, como

movimientos en masa, entre otros riesgos.

De esta manera se logra delimitar tres areas detalladas a continuacion: (Ver Anexo
20)

Tabla 14.

Subclasificacién del suelo del area de estudio

Subclasificacion del Suelo Area (Ha) Porcentaje
Suelo consolidado 52.26 27.53
Suelo no consolidado 110.20 58.05
Suelo de proteccion 27.37 14.42%
TOTAL 100

Nota: Fuente: (PUGS, 2020) Modificado por: La autora, 2024

La clasificacion del suelo urbano se ha realizado de manera detallada, dividiéndolo
en suelo urbano consolidado, suelo no consolidado y suelo de proteccion. Este
resultado busca proporcionar una base solida para la planificacion urbana que permita
un manejo adecuado segun las caracteristicas de cada tipo de suelo. En este contexto,
se indica la predominancia de “suelo no consolidado” con 110.20 ha. que abarca el
58.05% del area de estudio y muestra como tal la falta de servicios esenciales,

infraestructura, red vial y equipamientos, seguido se obtuvo 52.26 ha. de “suelo
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consolidado” abarcando claramente el casco céntrico representando 27.53% del area

y finalmente el “suelo de proteccion” abarcando el 14.42% del &rea urbana.

6.3 Resultados del tercer objetivo
6.3.1 Ocupacion del Suelo

Para la obtencion del mapa final de ocupacion del suelo se digitalizo cada una de
las edificaciones existentes dentro del limite urbano, mediante el uso de ortofoto y el

levantamiento en campo.

La ocupacion del suelo hace referencia a la cantidad de construccion presente en
cada parcela a nivel de la planta baja. La evaluacion de este nivel se realiza
considerando la proporcién entre el area construida y el area total de la parcela,
expresada como un porcentaje, y se conoce como Coeficiente de Ocupacion del Suelo
(COS).

Una vez obtenido el COS, se calcula el area edificable, nivel de ocupacién y area
vacante con la ayuda de las formulas descritas anteriormente en la metodologia. (Ver
Anexo 21)

Concluido el proceso de determinacion de la ocupacién del suelo, destacando que
se llevd a cabo un andlisis a nivel de manzanas con el propoésito de facilitar la
formulacion de propuestas para el tratamiento y aprovechamiento del suelo,
establecer rangos de ocupacion se vuelve crucial en este contexto, ya que permite la
creacion de categorias que agrupen las zonas urbanas de manera homogénea. Al
hacerlo, se logra una clasificacion mas detallada y precisa de las areas urbanas en

funcion de sus caracteristicas de ocupacion del suelo.

Tabla 15.

Clasificacion por rangos de ocupacion de suelo

Categoria Rango Area (ha) Porcentaje
Formacion 0-25 66.47 45.79
Desarrollo 25-50 41.54 28.62
Complementacion 50-75 20.18 13.9
Consolidacién 75-100 16.74 11.53
Sobreocupacion >100 0.23 0.16

Nota: Fuente: (PUGS, 2020) Modificado por: La autora, 2024

Una vez obtenido la clasificacion de nivel de ocupacion por rangos, se obtuvo el

mapa final de ocupacion del suelo. Obteniendo mayor porcentaje la categoria de
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“formacion” que abarca el 45.79% y tiene un rango de ocupacion de 0 a 25 es decir
gue esta minimamente edificado y existen algunas carencias en servicios basicos y

servicios de soporte.

Seguido, se obtuvo la ocupacion de “desarrollo” que representa el 28.62% con un
rango de ocupacion de 25 a 50 y se encuentra ubicada principalmente a los
alrededores de la parte céntrica y en las periferias. La ocupacién de
“‘complementacion” representa el 13.9% vy tiene un rango de ocupacién de 50 a 75,
por lo tanto tiene un gran porcentaje de area edificada pero como su nombre lo indica
podria complementarse con otras infraestructuras de equipamiento para su posterior
consolidacion, luego se obtuvo la categoria de “consolidacién” que abarca el 11.53%
y se encuentra ubicada en su mayoria en la parte central del &rea, debido a que existe
mayor consolidacion se servicios basicos, redes de infraestructura y dinamismo

comercial.

La dltima categoria es la de “sobreocupaciéon” que se encuentra con un minimo
porcentaje de 0.16% y es una zona en la que, por motivos de riesgo deberia tomarse
algunas medidas de control y estar minimamente edificada, para lo cual se requiere

regulamiento y control sobre esta area.
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7. Discusion

De acuerdo al analisis de la ocupacion del suelo de la parroquia Vilcabamba se
obtuvo los siguientes resultados proporcionando un diagndstico integral del area de
estudio en Vilcabamba. La informacion geologica obtenida en el trabajo de campo
revela una variada litologia en el area de estudio. Aproximadamente un 70% esta
conformado por depdsitos aluviales, siendo esta la base predominante para la
ubicacion del 70% del &rea urbana de la parroquia. En el sector oeste, se identificaron
depdsitos coluviales provenientes de elevaciones mas altas, mientras que en la parte
oriental se encontré la Unidad Chiglinda, un basamento compuesto por rocas
metamorficas como esquistos y cuarcita. Se observo que en la parte oeste una
pequefia porcion del area urbana se asienta sobre esta unidad, exponiendo la
importancia de la diversidad geoldgica que influye en la planificacion y ocupacioén del

suelo en la region.

En cuanto a la topografia, el andlisis del mapa de pendientes destaca la
predominancia de &reas con pendientes suaves, muy suaves y medias, cubriendo el
78.69% del territorio. Las pendientes fuertes, muy fuertes y escarpadas, que
constituyen el 8.11%, se localizan en la parte oriental principalmente en la unidad
Chiguinda, limitando su ocupacioén y resaltando la importancia de consideraciones
geograficas en la planificacién urbana.

Este resultado indica la importancia de tener en cuenta tanto la litologia como la
topografia en la toma de decisiones para la planificacion del uso del suelo, como se
puede dar cuenta las areas con pendientes fuerte a escarpadas presentan un minimo
numero de viviendas, mientras que en los depdsitos aluviales que existen desde
pendientes planas a medias, se encuentra asentada y consolidada la mayor parte de

la poblacion.

La comparacién entre el Plan de Uso y Gestién del Suelo de Vilcabamba (PUGS)
de 2020 y los datos actuales revela un cambio significativo en la dinamica urbana de
la parroquia. En un lapso de cuatro afios, el nUumero de predios ha experimentado un
notorio aumento, pasando de 939 predios en 2020 a 1171 predios en enero de 2024.

Este incremento evidencia un marcado crecimiento urbanistico.

En términos de infraestructura, el analisis de la capa de rodadura revela que el

asfalto predomina con un 40.95%, resaltando su relevancia para la conectividad. Sin
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embargo, se identifican areas sobre todo en la periferia con necesidades de mejora
en la red vial, esto sugiere que se debe tomar decisiones estratégicas para garantizar
buen estado de conectividad de la cabecera parroquial. Es importante mencionar que
en comparacion al PUGS del 2020 el &rea de estudio no ha tenido cambios notables
en lo que se refiere a la capa de rodadura, durante el trabajo de campo se evidencié
que el asfalto Unicamente se ha extendido apenas 1.95%, por lo que es notable la

despreocupacion por la mejora en la red vial.

En relacién con la cobertura de predios respecto a servicios basicos, es crucial
destacar las mejoras en la infraestructura basica que ha acompafiado el desarrollo
parroquial. La cobertura de energia eléctrica ha alcanzado una notable expansion,
abarcando el 92.40% de los predios en comparacién con el 2020. Asimismo, el
alcantarillado ha experimentado un crecimiento, pasando del 57.91% al 64.73% en el
mismo periodo. Sin embargo, aun asi, es limitada la cobertura de alcantarillado,
especialmente en las areas periféricas, lo que sefiala deficiencias en la planificacion y
ejecucion de servicios basicos esenciales. Las dificultades relacionadas con la
topografia y geografia indican la necesidad de abordar estos desafios de manera
efectiva para mejorar la cobertura y garantizar un acceso adecuado a servicios

sanitarios.

En cuanto a equipamientos, la cobertura actual satisface las necesidades de la
cabecera parroquial, pero se sefiala la necesidad de planificacidn futura para nuevos
centros educativos, recreativos y de seguridad publica, considerando el notorio
crecimiento y consolidacion de la parroquia en los ultimos afios. Cabe mencionar, la
adicién de cinco nuevos elementos es un reflejo directo del esfuerzo por promover el
bienestar de la poblacién. Destacan dos centros dedicados a la atencién del adulto
mayor. A su vez, la construccion del coliseo municipal, el terminal terrestre y una

cancha deportiva contribuyen a la consolidacion y desarrollo de la parroquia.

A pesar del notable aumento en el nimero de predios, la distribucién actual del uso
del suelo en Vilcabamba muestra estabilidad en comparacién con los datos de 2020.
Este suceso indica una capacidad de planificacion y gestion eficaz por parte de las
autoridades locales, dado que los porcentajes asociados a distintas categorias de uso
del suelo han mantenido una coherencia sustancial. Por ejemplo, aunque el nimero
de predios vacantes ha disminuido del 16.40% al 12.72%, y los predios destinados a
vivienda han experimentado un aumento del 70.29% al 74.77%, la distribucion general

48



se ha preservado y la cabecera parroquial se ha ido consolidando de a poco a los

alrededores del casco céntrico.

En términos de subclasificacion del suelo, se observa una expansién minima del
suelo urbano consolidado, ubicado en la parte céntrica de la cabecera parroquial. Esta
area, que alberga la mayoria de los equipamientos y servicios basicos, ha
experimentado un crecimiento pequefio, pero refleja la dinadmica y vitalidad del ndcleo
urbano. Por otro lado, el suelo urbano no consolidado ha disminuido ligeramente en
un 2.35%, lo cual se atribuye a la falta de vialidad adecuada y servicios basicos, asi
como a limitaciones topograficas, pendientes fuertes que han resultado en

concentraciones dispersas de viviendas.

La subclasificacion de suelo de proteccidn, se encuentra estrechamente vinculada
a las zonas de riesgo previamente identificadas e indica la importancia de las areas
ubicadas en los margenes de rios y quebradas, debido a su clasificacion como zonas
de riesgo inadecuadas para la construccion, debido a la potencial amenaza de
inundaciones o0 desbordamientos. Estos eventos naturales pueden tener
consecuencias significativas en la seguridad y estabilidad de las estructuras y, por
ende, para la poblacion que reside en esas areas. La consideracion de estos riesgos
en la planificacién urbana es esencial para toma de decisiones en regulacion y control

por parte de las autoridades.

Ademas, el analisis de la pendiente del terreno, especialmente aquellas que
superan el 40%, indica que la topografia, la gravedad y las actividades humanas
pueden desencadenar problemas potenciales, como movimientos en masa. En
terrenos inclinados, existe un riesgo mayor de deslizamientos de tierra u otros
fendmenos relacionados con la inestabilidad del suelo. Esta consideracion es crucial
para prevenir eventos catastroficos y garantizar la habitabilidad segura de las areas
urbanas, al tomar medidas preventivas y restricciones en zonas propensas a dichos

riesgos.

Por ultimo, la clasificaciéon detallada de la ocupacién del suelo revela una
predominancia del tipo "formacion" (45.79%), indicando &reas minimamente
edificadas con deficiencias en servicios basicos, evidenciando la necesidad de
mejorar la infraestructura. La categoria "desarrollo” (28.62%) muestra un nivel

intermedio, ubicandose mayormente en los alrededores del centro y periferias, con
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posibilidad de mejoras e infraestructuras y dotacion de servicios. "Complementacion”
(13.9%) expone un desarrollo considerable, pero con la posibilidad de
complementarse con otras infraestructuras, indicando la necesidad de una
planificacion adecuada. La "Consolidacion” (11.53%) se concentra en la parte central,
indicando mayor consolidacion de servicios basicos y actividad comercial, existe 3
sectores consolidados que se encuentran cerca de la periferia debido a que cuentan
con todos los servicios bésicos, sin embargo, por encontrarse en la zona de
“‘pendientes fuertes a escarpadas” no es una zona en la cual deba aumentarse los
asentamientos humanos y en la actualidad se encuentra cumpliendo con el coeficiente
de ocupacion del suelo permitido. La "Sobreocupacion” (0.16%) sefiala areas de
riesgo, toma de decisiones urgente acerca del control de construcciones en estas
zonas y medidas de gestion para el crecimiento prudente del area.

El analisis detallado de estos elementos sugiere que Vilcabamba esta
experimentando un desarrollo, aunque acelerado pero sustancial, abordando no solo
la expansion urbana sino también tomando en cuenta pardmetros importantes tales

como, litologia, pendientes, margenes de proteccion y zonas de riesgo.

Finalmente se comprueba la validez de esta metodologia y se considera que los
resultados obtenidos guardan bastante relacion con la realidad espacial y
consecuentemente sirvi6 como informacion de apoyo Yy verificacion para la
actualizacion del Plan de Uso y Gestion de Suelo del canton Loja, y servira como

referente para posteriores trabajos de planificacion territorial.
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8. Conclusiones

El diagnéstico urbano de Vilcabamba ofrece una vision detallada, actualizada y
esencial para la gestibn y planificacion urbana. Destaca la importancia de la
delimitacién urbana y revela la diversidad geoldgica, resaltando la predominancia de
depdsitos aluviales y la presencia de depdsitos coluviales y la Unidad Chigtinda en

menor extension.

El andlisis topogréafico muestra la prevalencia de pendientes suaves y medias, con
areas mas pronunciadas en la unidad Chiglinda, limitando la expansion urbana y los
asentamientos humanos en dichas zonas. En términos de infraestructura, el asfalto
predomina, pero se identifican areas que requieren mejoras en la red vial. Aunque el
acceso a agua potable y energia eléctrica es alto, la limitada cobertura de
alcantarillado, especialmente en las periferias, sefiala ineficiencia en los servicios
basicos. En conjunto, el diagnostico proporciona una base integral para la toma de
decisiones en la gestion urbana, mostrando la importancia de considerar variables
como geologia, topografia, infraestructura y servicios para el desarrollo de

Vilcabamba.

En el &rea de estudio, la subclasificacion del suelo destaca la minima expansion del
suelo urbano consolidado en la cabecera parroquial, donde se concentran
eguipamientos y servicios basicos. El suelo urbano no consolidado abarca el 58.05%,
y el suelo urbano consolidado conforma el 27.53%, evidenciando la importancia de
mejorar las redes de cobertura de servicio basicos para un desarrollo eficiente y
equitativo. La disminucion del suelo urbano no consolidado se atribuye a la falta de
vialidad y servicios basicos, junto con limitaciones topograficas. El suelo urbano de
proteccion, ocupando el 14.42%, refleja la preocupacion por la preservacion ambiental

y mitigacion de riesgos.

La subclasificacién de suelo de proteccion evidencia una planificacion estratégica
para prevenir dafios por inundaciones o riesgos, indica la restriccién en pendientes
pronunciadas y la probabilidad de existir procesos erosivos, destacando la importancia

de medidas preventivas ante actividades humanas generadoras de riesgos.

En los dltimos cuatro afios, Vilcabamba ha experimentado un notable crecimiento
urbano, con un aumento de predios de 939 en 2020 a 1171 en enero de 2024. Este

desarrollo ha sido acompafiado por mejoras especificas y sustanciales en
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infraestructura basica, destacando aumentos significativos en la cobertura de energia
eléctrica (92.40%) y alcantarillado (64.73%), aunque esta Ultima aun presenta

deficiencias en cobertura.

El mapa final de ocupacion del suelo indica que la categoria "formacion” predomina
con un 45.79%, caracterizada por una ocupacion minima y deficiencias en servicios
bésicos. La categoria "desarrollo” ocupa el 28.62%, principalmente en areas céntricas
y periféricas. La ocupacion de "complementacion” representa el 13.9%, muestra
potencial para infraestructuras adicionales. La "consolidacion" abarca el 11.53%,
concentrandose en la parte central con mayor consolidacién de servicios basicos y
actividad comercial. La categoria de "sobreocupacién" es minima, 0.16%, indicando

riesgos y la necesidad de medidas de control.
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9. Recomendaciones

Se recomienda una planificacion urbana integral que tenga en cuenta la
delimitacion urbana, la diversidad geoldgica y topografia para asegurar el
desarrollo de la parroquia

Dada la identificacion de areas que requieren mejoras en la red vial, se
sugiere priorizar proyectos de mejora y expansion de la infraestructura vial
para garantizar una conectividad eficiente.

Aunque el acceso a agua potable y energia eléctrica es alto, la limitada
cobertura de alcantarillado en las periferias indica deficiencias en los
servicios basicos. Se recomienda mejorar la cobertura de alcantarillado vy el
sistema de aguas residuales.

La necesidad de planificacién futura para nuevos equipamientos indica
crecimiento demogréfico, por lo tanto, se recomienda desarrollar e
implementar planes para nuevos centros educativos, recreativos y de
seguridad publica.

Ante el crecimiento urbano significativo, se sugiere implementar medidas de
regulacion y control para nuevos asentamientos humanos que aseguren un
desarrollo urbano sostenible, considerando la preservacion ambiental y la
mitigacion de riesgos.

La categoria de "complementacion” en la ocupacién del suelo indica
potencial para infraestructuras adicionales. Se recomienda promover y
planificar el desarrollo de infraestructuras complementarias en estas areas
para que puedan consolidarse.

La "Sobreocupacion” sefala areas de riesgo, por lo que se sugiere la toma
de decisiones urgente acerca del control de construcciones en estas zonas
y medidas de gestion para el crecimiento prudente del area.

Fomentar la participacion comunitaria en el proceso de planificacion y
gestion urbana para asegurar que las decisiones reflejen las necesidades de

la poblacion local.
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11. Anexos

Anexo 1. Ficha de descripcion de afloramientos

Fecha: UBICACION GEOGRAFICA
Nro. de Afloramiento
_ - Coordenadas UTM
Tipo de Afloramiento
(WGS 84)
Formacion
GEOMETRIA DEL AFLORAMIENTO
Altura -- Direccién --
Longitud - Buzamiento -
CARACTERIZACION DEL AFLORAMIENTO
Cobertura Vegetal Tipo de roca o material
Estado del afloramiento Presencia de estratos

DESCRIPCION DEL AFLORAMIENTO

FOTOGRAFIA
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Anexo 2. Ficha para levantamiento de equipamientos.

Provincia Parroquia
Canton Zona: 17S
o Coordenadas:
. ) ) Descripcié .
Categoria | Equipamiento UTM WGS 84 Fotografia
n
X Y
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Anexo 3. Limite de distancia en metros segun ambito de aplicacion.

Radio de Poblacién
Escala Tipo Definicién Establecimiento influencia servida
(m) (habitantes)
Centros
Barrial educativos, inicial, 400 2000
preescolar y
general basico
Colegio,
secundario,
Local Unidad Educativa 1000 20000
(nivel basico u
bachillerato)
Centros de
Corresponde a Ed_ucac[on_
Especial, Técnica,
. Ios_ Artesanal, Laboral
equipamientos Ocu aéional ’
Ciudad destinados a la Inve_Eti acién‘ 2000 50000
formacion Experimgntacién
. intelectual, ’
EDUCACION capacitacion y Escuglad- Taller,
preparacion de Univeersﬁzrias
los individuos
para su
e campus
Universitarios,
Centros
_ tecnolégicos, Cobertura
Regional o Centros de Reqional - 200000
cantonal Educacién eglona
: Cantonal
Superior y
Escuelas
Politécnicas
Superiores
Puestos de salud,
subcentros de
Barrial salud, consultorios 500 2000
médicos y
dentales
Corresponde a
los
equipamientos
destinados ala  Centros de salud,
prestacion de clinicas (15
SALUD salud como camas),
Local prevencion, consultorios (20 1500 20000
tratamiento, unidades), hospital
rehabilitacion,  del dia, Unidades
servicios de emergencia
quirdrgicos y de
profilaxis.
Hospital general,
Ciudad clinicas - hospital, 3000 50000

Consultorios (+20
u), Hospital del dia
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Hospital de
Especialidades

Regional o (>20 camas), Cobgrtura 200000
cantonal C Regional
entros de reposo
y rehabilitacién
Casa Comunal,
Barrial 'br?fo.ce””o' 400 5000
ibliotecas
barriales.
Bibliotecas,
Corresponden a galeritas pulblicg\s
; e arte, salas de
Local |23iﬁ§g?ggzsy exposicior_wes_, 1000 20000
destinados a las  teatros, auditorios
actividades y cines de hasta
culturales, 150 puestos.
custodia,
CULTURA transmision y
conservacion
del Centros de
. conocimiento, promocién’
Ciudad fomento y culturales museos 2000 50000
difusion de la escénicos.
cultura
Casa de la cultura,
Regional o Hemeroteca, Cobertura 200000
cantonal Cinemateca mayor Regional
150 puestos.
Centros infantiles,
Barrial guarderias y casas 400 2000
Corresponde a cuna
las
edificaciones y
dotaciones de
asistencia no Asistencia social,
especificament  aldeas educativas,
Local e sanitarias, centros juveniles y 1500 20000
destinadas al familiares.
desarrollo y la
INCLUSION SOCIAL promocién del
bienestar social,
con actividades
de informacion, Albergues de
orientacion y asistencia social
prestacion de (>50 camas),
Ciudad servicios a centros 2000 50000
grupos gerontoldgicos,
humanos lugares para
especificos. poblacién adulto

mayor, orfanatos.
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Centro de

Regional o Proteccion de Cobgrtura 200000
cantonal Regional
menores
El equipamiento
deportivo y de Canchas
Barrial recreacion deportivas 400 2000
Corresponde a (Basquet, V0|8Ib0|,
las areas, futsal)
edificaciones y
dotaciones
destinadas a la Piscinas,
practica del complejos
Local ejercicio fisico,  deportivos, centros 1000 10000
] al deporte de deportivos.
RECREACION Y alto rendimiento
DEPORTE y a la exhibicion
de la .
competencia de COE)T:::S()%O
Ciudad actividades polideportivos 2000 20000
deportivas, y especiales y de
por los espacios p oSy
espectaculos.
verdes de uso
colectivo que
Regional o actian come Estadios, coliseos Cobertura
cagntonal reguladqrgs ael (+500 plazas) Regional 100000
equilibrio zoolégico. 9
ambiental
Capillas, Grutas
Local (hasta 200 1000 5000
puestos)
Comprende las o
_ edificaciones ~ Templos e iglesias
Ciudad para la (hasta 500 2000 20000
celebracion de puestos)
los diferentes
cultos. Catedral,
Regional o Monasterios, Cobertura
cantonal conventos (> 500 Regional 200000
puestos)
Unidad de Control
Barrial del Medio 500 2000
Ambiente
Local Retenes y UPC 1000 20000
Comprende
areas, Cuarteles
Ciudad e'dlflcaCIC_)neS e PoII(_:IaIeS y 2000 50000
instalaciones Estaciones de
dedicadas ala  bomberosy UVC
SEGURIDAD seguridad y
proteccion civil. Cuarteles
Regional o Militares, Centros Cobertura
9 de Rehabilitacién, : 250000
cantonal . o Regional
penitenciarias,
carceles
Son areas,
edificaciones e Funeraria,
. SERVICIO instalaciones Cementerio
Ciudad FUNERARIOS dedicadas a la parroquial, salas 1500 20000
velacion, de velacion, osario
cremacion,
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inhumacion o
enterramiento

de restos Parque
Camposanos,
. Fosas, nichos,
R:agrll?onr?s!uo criptas, osarios y %Oe%?;t#;? 100000
columnarios
adscritos al
cementerio,
crematorios.
Agencias, sedes
de gremios y
Local federaciones 300 5000
profesionales.
Son las areas, Municipio y
Ciudad edificaciones e  empresas publicas Ciudad 50000
SERVICIOS DE instalaciones municipales.
ADMINISTRA-CION ~ destinadas a fas
PUBLICA administrativas o
en todos los Sedes prmmpales
niveles. gle entldadets
. publicas y centros
R:agrfg‘rf‘;lo administrativos %%%‘“Tg#;? 200000
nacionales,
provinciales y
distritales.
Barrial Paradas de bus 300 500
Terminal de buses
Esel urbanos, taxis y
equipamiento camionetas,
de servicio centros de
Local publico que revision, 1000 5000
facilita la parqueaderos
movilidad de puablicos
personasy motorizados y no
vehiculos de motorizados
transporte, son
TRANSPORTE e'dificacic_)nes e
instalaciones
destinadas a la .
movilidad de E?ta‘:'onef de
P ransporte,
Ciudad Vterglrfil)?)srt? Interparroquial, de 3000 50000
piblico y transferencia y de
privado. carga.
. Terminal
Rcezgr:(t)(?ri":llo Interprovincial, (:Roet;ei(r)t#;? 200000
Aeropuertos
Es el
Local equipamiento Mercado minoris_ta, 1500 10000
para Centro de Acopio
APROVISIONA- intercambio de
MIENTO bienes
) productos Mercado
Ciudad perecibles y no mayorista, Camal 3000 100000
municipal.

perecibles que
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Regional o
cantonal

brindan un

servicio de Terminal
mercadeo o Pesquero,
mercado. Campos feriales
(agropecuarios),
CIAL.

Cobertura
Regional

200000
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Anexo 4. Mapa de Delimitacién Urbana
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Anexo 5. Mapa de litologia
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Anexo 6. Fichas de afloramientos

Fecha: 2023 -12-18 UBICACION GEOGRAFICA
Nro. de Afloramiento 1 X=697833
_ . Coordenadas UTM
Tipo de Afloramiento Natural Y= 9528779
(WGS 84)
Formacion Deposito Aluvial Z= 1546

GEOMETRIA DEL AFLORAMIENTO

Altura -- Direccioén --

Longitud -- Buzamiento --

CARACTERIZACION DEL AFLORAMIENTO

_ i Tipo derocao
Arbustiva y arbérea

Cobertura Vegetal material
Presencia de
_ Estable No
Estado del afloramiento estratos

DESCRIPCION DEL AFLORAMIENTO

En la foto se puede observar el material aluvial que se ha depositado a lo largo de las riveras
del rio y es el Unico lugar en el que se puede identificar estos depdsitos, debido a que el

resto del area de esta cubierta por asentamientos humanos.

FOTOGRAFIA
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Fecha: 2023 -12-18 UBICACION GEOGRAFICA
Nro. de Afloramiento 2 X=697833
: _ : Coordenadas UTM
Tipo de Afloramiento Antrépico Y= 9528779
(WGS 84)
Formacion Deposito Coluvial Z=1608

GEOMETRIA DEL AFLORAMIENTO

Altura 2 metros Direccion --

Longitud 13 metros Buzamiento --
CARACTERIZACION DEL AFLORAMIENTO

_ i Tipo derocao
Arbustiva y arbérea

Cobertura Vegetal material
Presencia de
_ Estable No
Estado del afloramiento estratos

DESCRIPCION DEL AFLORAMIENTO

Este afloramiento se encuentra en la parte occidental del area urbana perteneciente a los
depdsitos coluviales constituido por fragmentos angulares y subangulares de rocas

metamorficas de filitas y esquistos, sostenidas en una matriz limo arcillosa.

FOTOGRAFIA
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Fecha: 2023 -12-18 UBICACION GEOGRAFICA
Nro. de Afloramiento |3 X=698210
_ - _ Coordenadas UTM
Tipo de Afloramiento | Antrépico Y= 9528852
(WGS 84)
Formacion Deposito Coluvial Z= 1573

GEOMETRIA DEL AFLORAMIENTO

Altura 2 metros Direccion --

Longitud 6 metros Buzamiento --
CARACTERIZACION DEL AFLORAMIENTO

Herbaceay Tipo derocao
Cobertura Vegetal arbustiva material
Estado del Presencia de
] Estable No
afloramiento estratos

DESCRIPCION DEL AFLORAMIENTO

Estos depdsitos exhiben una disposicion desordenada de clastos de diversos
tamafos, compuestos mayormente por rocas metamorficas como filitas y esquistos,
los cuales presentan formas angulares y subangulares. Se generan a través de

procesos de alteracion in situ de las rocas localizadas en las laderas superiores.

FOTOGRAFIA

1A
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Fecha: 2023 -12-18 UBICACION GEOGRAFICA
Nro. de Afloramiento 4 X=698438
_ - _ Coordenadas UTM
Tipo de Afloramiento Antrépico Y= 9528749
(WGS 84)
Formacion Deposito Aluvial Z=1607

GEOMETRIA DEL AFLORAMIENTO

Altura 5 metros Direccion --

Longitud 6 metros Buzamiento --
CARACTERIZACION DEL AFLORAMIENTO

Tipo derocao

Herbacea )
Cobertura Vegetal material
Presencia de
_ Estable No
Estado del afloramiento estratos

DESCRIPCION DEL AFLORAMIENTO

En este afloramiento existe presencia predominante de rocas metamorficas de bajo
grado, especialmente esquistos sericiticos y exhiben tonalidades rojizas debido a las
oxidaciones de hierro, asi como variados matices de grises y verdes. Ademas, se
observa la presencia de cuarcita en proporciones menores, destacando por su color

blanco grisaceo.

FOTOGRAFIA
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Anexo 7. Mapa de topografia
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Anexo 8. Mapa de Pendientes
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Anexo 9. Mapa de sectorizacion
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Anexo 10. Mapa de capa de rodadura
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Anexo 11. Mapa de areas verdes
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Anexo 12. Mapa de cobertura de agua potable
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Anexo 13. Mapa de cobertura de alcantarillado
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Anexo 14. Mapa de cobertura de energia eléctrica
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Anexo 15. Mapa de equipamientos

S ».

! Tty g
g b P :‘::::-::T g
= 3 prtn o] b=
8 w i 7 2
‘ 72
8 |/ Vilcabamba| -
gt ‘ ! 8
o X ? =3
[=] Jd ) °

b3 \Vilcabamba Quinara
11 =% | 7 Yangana o
2 | &
g R QN L 5

R e S s s =4

660000 680000 700000 720000 690000 700000 710000
LEYENDA
: . — Rj0S
Area de estudio
Quebradas
| Predial -
Via principal
EQUIPAMIENTOS

Administraciéon Publica
Aprovisionamiento
Culto

Educacién

Inclusién Social
Recreacién y Deporte
Salud

Seguridad

ON N NoNoN N N N¢

Transporte

Sistema de coordenadas: WGS 1984 UTM Zone 17S
Proyeccion: Transverse Mercator
Datum: WGS 1984
Unidades: Meters

UNIVERSIDAD NACIONAL DE LOJA

FACULTAD DE LA ENERGIA, LAS INDUSTRIAS Y LOS RECURSOS
NATURALES NO RENOVABLES

CARRERA DE GEOLOGIA AMBIENTAL Y ORDENAMIENTO TERRITORIAL

TEMA: EQUIPAMIENTOS DEL AREA DE ESTUDIO

|Rea|izado por:| Gabriela Cecibel Macancela

” Escala real:

| 15000

[Revisa:

I Ing, Jeanine Asanza

” Escala de impresién: | 1:8.500

[Fecha: | 1011212023 || Lamina | 11 de17

3 \
S
el
o
3
g
3
VILCABAMBA
8
S
o
3
1 “Hospital Basico ’
Agencia Muriicipal
Agencia Murniciprat‘ i
2 4 (Ylesial /| Preescolar _ Colegio Tamm|
8 0 greich Ol e =
o rminal [ Y : )
Eséuel‘al"l oDl = — N
Coliseo Asrst?nma Socia
8 __Cancha eportival /| ’
@ (& =0 - = = =
\
0.2 0.1 0 0.2 0.4 0.6
8 L e — |< 1)
2 [
8 i
3 |
T T T T
696800 697200 697600 698000 698400

698800

76



Anexo 16. Fichas de equipamientos del area de estudios

Provincia Loja Parroquia Vilcabamba
Cantoén Loja Zona: 17S
) ) Coordenadas:
. |Equipamient L i
Categoria Descripcion UTM WGS 84 Fotografia
o]
X Y
Centro de
Educacién
Inicial Fiscal
Preescolar 697470 9528788
“Antonio
José Pefia
Celi”
Escuela
Fiscal Mixta
Escuela 697139 9528646
Juan
Montalvo
Educacién
Escuela de
Escuela |nifias “13de| 697298 9528773
abril”
Colegio
Colegio Mixto 697668 | 9528795
“Vilcabamba”
) Coliseo
Coliseo o 697278 | 9528453
Municipal
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Recreacion

y Deporte

Parque

Parque
Central de

Vilcabamba

697268

9528826

Parque

Parque de
“La Madre”

697173

9529392

Cancha

Cancha

Deportiva

696914

9528394

Culto

Iglesia

Iglesia de

Vilcabamba

697256

9528783

Salud

Hospital

Hospital
Basico de

Vilcabamba

697253

9529070

Administra
cién

Publica

Casa

Comunal

Casa
comunal y
oficinas del

GAD

parroquial

697293

9528867

Transporte

Terminal

Terminal

Terrestre

697075

9528738
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Mercado

Aprovision .
) Mercado |Municipal de| 697104 | 9528715
amiento i
Vilcabamba
Asistencia | Centro del
) 697558 | 9528475
Social adulto Mayor
Inclusion
Social Talleres
Asilo de Centro
) | 697134 | 9529349
ancianos |Gerontolégic
0
) UPC,
i Agencia
Seguridad o Destacament| 697305 | 9528939
municipal .
o policial

79



Anexo 17. Mapa de Patrimonio Cultural y arquitecténico
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Anexo 18. Mapa de Uso de suelo actual
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Anexo 19. Mapa de suelo vacante
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Anexo 20. Mapa de subclasificacion del suelo
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Anexo 21. Tabla de calculos de nivel de ocupacion

Nro. Area Area CcoS Area Nivel de Area
Manzan (manzana edificada PB edificable Ocupacion Vacante
a )
1 3822.73 1823.57 70 2675.91 68.15 852.34
2 3142.56 2131.33 70 2199.79 96.89 68.47
3 4569.41 2419.01 70 3198.59 75.63 779.57
4 4532.55 1368.68 70 3172.78 43.14 1804.1
5 7228.6 2370.62 70 5060.02 46.85 2689.4
6 4282.14 462.99 70 2997.5 15.45 2534.51
7 3211.86 1464.98 70 2248.3 65.16 783.33
8 3171.58 0 70 2220.11 0 2220.11
9 3742.74 2170.43 70 2619.92 82.84 449.49
10 3926.23 1288.51 70 2748.36 46.88 1459.85
11 5642.88 1807.44 70 3950.01 45.76 2142.57
12 77689.26 4038.37 30 23306.78 17.33 19268.41
13 13704.3 1534.69 30 4111.29 37.33 2576.6
14 32048.53 2522.9 30 9614.56 26.24 7091.66
15 198446.41 14794.18 20 39689.28 37.28 24895.1
16 90101.92 6295.75 30 27030.58 23.29 20734.83
17 7697.29 1197.09 50 3848.65 31.1 2651.56
18 5305.93 1522.34 50 2652.97 57.38 1130.63
19 2460.3 333.03 50 1230.15 27.07 897.12
20 91121.42 4541.01 5 4556.07 99.67 15.07
21 5145.39 939.97 30 1543.62 60.89 603.64
22 26677.17 1222.43 5 1333.86 91.65 111.42
23 5139.15 861.52 70 3597.41 23.95 2735.89
24 4921.28 345 70 3444.9 10.01 3099.9
25 71645.33 2243 5 3582.27 62.61 1339.27
26 4811.42 2478.12 70 3368 73.58 889.87
27 4522.13 1964.52 70 3165.49 62.06 1200.97
28 4306.03 2393.82 70 3014.22 79.42 620.4
29 4386.58 2424.07 70 3070.61 78.94 646.54
30 5080.58 2046.29 70 3556.4 57.54 1510.12
31 6595.67 1849.77 70 4616.97 40.06 2767.19
33 4009.23 988.47 70 2806.46 35.22 1817.99
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Anexo 22. Mapa de ocupacion del suelo
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Datum: WGS 1984
Unidades: Meters

UNIVERSIDAD NACIONAL DE LOJA

FACULTAD DE LA ENERGIA, LAS INDUSTRIAS Y LOS RECURSOS
NATURALES NO RENOVABLES

CARRERA DE GEOLOGIA AMBIENTAL Y ORDENAMIENTO TERRITORIAL

| TEMA: OCUPACION DEL SUELO DEL AREA DE ESTUDIO

|Rea|izado por:l Gabriela Cecibel Macancela " Escala real: I 1:5.000

IRevisa: I Ing, Jeanine Asanza ” Escala de impresion: I 1:8.500

|F90h01 I 10/12/2023 " Lamina I 17 de 17

696800

697200

697600

698000

698400

698800

87



Anexo 23. Certificado de traduccion de resumen

Loja, 28 de febrero de 2024

Lic. Jaime Vicente Jumbo Jumbo

Certified English Teacher

CERTIFICO:

Que el documento aqui compuesto es fiel traduccion del idioma espaiiol al idioma ingles,
del resumen del trabajo de titulacion, titulado “Ocupacion del suelo del area urbana de
la parroquia Vilcabamba, perteneciente al canton y provincia de Loja, con fines de
gestion y ordenamiento territorial” de autoria de la estudiante Gabriela Cecibel
Macancela Jumbo, con ntimero de cédula 1150030433, cgresada de la carrera de
Ingenieria en Geologia Ambiental y Ordenamiento Territorial, de la Universidad
Nacional de Loja,

Lo certifico en honor a la verdad, y, a su vez autorizo a la interesada a hacer uso del
presente para los fines que considere pertinentes.

Jaime Vicente Jumbo Jumbo

LICENCIADO EN CIENCIAS EN LA EDUCACION MENCION INGLES.
Numero de registro: 1008-02-151250

CI: 1103326771
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